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This chapter provides an overview of the purpose, workflow, features and system requirements for Antenna House
XSL Report Designer.

1  Purpose
Antenna House XSL Report Designer is for the designing of output layouts that can then be used to take XML
data and generate print or PDF reports and forms by using XSL-FO and Antenna House XSL Formatter or AH
Formatter. The output layout design contains the relationship of each element of XML content and how it should
be placed, formatted and processed in the final report or form.

XSL Report Designer is based on the XSL-FO standard and conforms to the W3C Recommendation for Extensible
Stylesheet Language (XSL-FO) Version 1.0 and 1.1. XSL Report Designer uses several extensions developed by
Antenna House for XSL Formatter or AH Formatter to handle some of the complex formatting requirements.
XSL Report Designer also uses XSL Formatter's GUI or AH Formatter's GUI to proof the forms and merged
XML content. Thus, to take full advantage of XSL Report Designer Antenna House XSL Formatter V4.0 or later,
or AH Formatter V5.0 or later is required to process/format the XSL-FO.

2  Workflow
The following explains the workflow from the designing of the layout with XSL Report Designer to generating
the final format and output of the report with XSL Formatter or AH Formatter.

Step1. Design the report

XSL Report Designer's intuitive Graphical User Interface (GUI) on Windows offers a true WYSIWYG (what you
see is what you get) for creating the report or the form layout interactively. The designed content is saved as a
Project File (extension is ".rxl") . You can also save it as an XSL stylesheet (extension is ".xsl") .

Step2. Create XSL-FO with Runtime Engine or XSLT software

To create an XSL-FO file XSL Report Designer comes with a separate Runtime Engine that is used to process
the XML data by using the Project File designed in Step 1.

Report Designer also enables a layout to be saved as an XSL file. By using an XSLT processor the XML data can
be transformed using the XSL stylesheet to generate XSL-FO.

Later in this document we will discuss the limitations surrounding the use of XSLT and the advantages of the
Project File and Runtime Engine.
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Step3. Format the XSL-FO with XSL Formatter or AH Formatter

The final step is taking the XSL-FO and using XSL Formatter or AH Formatter to create a file for screen display,
paper output or PDF.

3  Features
The following are some of the main features of XSL Report Designer:

■ Requires no knowledge of stylesheets or programming to design reports and forms from XML data.
To print XML data in forms and reports does not require the design of complex stylesheets and programs.
To design a form now requires the simple use of a mouse and GUI to associate and layout the data for the
report.

■ Supports three layout types.
With Report Designer you have three layout types to choose from; Fixed layout for rigid forms, Flow
layout for forms that have expanding fields to accommodate the data and Label layout for multiple forms
(labels) on a page.

■ Set complex formats and the expressions easily.
Complex processing can be specified and executed easily with the wide range of format specifications and
built-in functions (string manipulation, total processing, conditional judgment, xpath specification, etc.)
easily accessible from the GUI.

■ Generate XSL stylesheets. (V2.0)
XSL stylesheets can automatically be generated from the Project File. Then a standard XSLT processor
can be used to convert the XML data to XSL-FO.

■ Supports the use of TSV/CSV data. (V2.0)

http://www.antennahouse.com/product/axfo40/axfo4top.htm
http://www.antennahouse.com/product/ahf50/ahf5top.htm
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Existing TSV (Tab Separated Values) / CSV (Comma Separated Values) files can now be formatted the
same as XML files. Using Report Designer a Project File can be created to format TSV/CSV files the same
as if they were XML data.

■ Possible to use PDF file as a draft design. (V2.5)
When you design the layout of your file, an existing PDF file can be used as a base draft. By doing this,
you can easily design the layout of the same design as your existing PDF form. It is also possible to output
the PDF used as a base draft together with data as background image.

■ Possible to change the properties of objects dynamically. (V2.5)
You can change the properties of objects(e.g. text color etc.) dynamically according to the data when
printing and outputting a PDF file.

■ Comes with a separate Runtime Engine to create XSL-FO.
The Runtime Engine is used to transform XML data to XSL-FO based on the specifications contained in
the Project File. The Runtime Engine supports a wide range of functions beyond what could be achieved
with XSLT. The Java Interface of the Runtime Engine is designed to enable the construction of systems
that require server side printing of reports. A command line interface is also available.

4  System Requirements

XSL Report Designer（GUI） Windows XP SP3 or later, Windows Vista SP1 or later.
Display: 16-bit color or higher
Memory: 512MB or higher

Runtime Engine Java SE (Java Platform, Standard Edition) 1.5.0 or later, or
JRE (Java Runtime Environment) 1.5.0 or later
Memory: 512MB or higer

■ To generate XSL-FO with an XSL stylesheet from Report Designer requires a separate XSLT processor.
The XSLT processor is not part of the product, but several are freely available. Antenna House has tested
Report Designer with both MSXML from Microsoft and Saxon from SourceForge.

■ The generation of XSL-FO requires a Java environment, "Antenna House XSL Formatter V4.0" or later,
or "Antenna House AH Formatter V5.0" or later is necessary to create the screen display (preview), print
and PDF output. Please refer to our Web site about the system requirements of Antenna House XSL
Formatter or AH Formatter.

■ "XSL Formatter Barcode Option", or "AH Formatter Barcode Option" is required to print barcodes. "XSL
Formatter Barcode Option" or "AH Formatter Barcode Option" is available only for Windows.

5  Additional information and technical support

For additional information and technical questions about XSL Report Designer please contact us at the following
e-mail.

Technical inquiries:
e-mail : designer@antennahouse.com

Sales, pricing and licensing:
e-mail : info@antennahouse.com

http://www.antennahouse.com/product/axfo40/axfo4top.htm
http://www.antennahouse.com/product/ahf50/ahf5top.htm
http://antennahouse.com/product/barcode.htm
http://antennahouse.com/product/barcode.htm
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This chapter explains the basic concept behind XSL Report Designer and how it produces a print layout.

6  Structure of XML data and the correspondence to the print
layout of the form or report
XSL Report Designer creates a layout design for printing predefined forms and reports containing XML data. The
XML data for printing is assumed to have a constant repetition pattern in the tree structure. It is not possible with
XSL Report Designer to design a layout for documents such as general books and technical manuals because they
do not have a constant repetition pattern within tree structure of their XML data.

XSL Report Designer matches the repetition pattern of the XML data to the repetition pattern in the print layout
of the form or report. To do this XSL Report Designer supports three types of print layouts; Fixed type, Flow type
and Label type. Let's take a look at how XSL Report Designer relates the repetition pattern of the tree structure
of the XML data to the repetition pattern in three kinds of print layouts.

6.1  Fixed type (used for predesigned fixed forms)

The Fixed type layout pattern repeats the same pattern on each page or group of pages as shown in the figure.
Thus, one repetition of the XML tree is applied to one page or group of pages in the final formatted output. In the
XML tree the element at the first position of the overall report or form is considered the main repeat element.
Whenever the main repeat element appears in the XML data a new page or group of pages is created in the report.

6.2  Flow type (used for reports and dynamic forms such as invoices
and statements)

The Flow type layout pattern is used when the XML data contain elements that are repeated multiple times in the
XML tree. The fields or pages in the report expand to accommodate the XML content onto the paper as shown
in the following figure. In the Flow type the limits of the page are not set by the unit of the repetition.
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6.3  Label type

The Label type divides the paper into user defined units, as shown in the following figure, called labels. The same
output pattern is repeated label by label by starting each new label at the main repeat element.

7  How XSL-FO is generated and printed from XML data
The layout that XSL Report Designer designs is called the "Project" and the information about the design is
preserved as a Project File.

The building blocks XSL Report Designer uses for a design are called "Objects." Though there are various kinds
of objects, the one most frequently used is a text object. Using the text object as an example, let's take a brief look
at how the process works.

In XSL Report Designer text objects are not concrete text character strings such as in DTP and word processors.
Instead the text objects are like an empty containers that ultimately will have text placed into them.

The text object supports two different kinds of text, "Static" and "Field." For the static text object the text character
string is input through XSL Report Designer's GUI. For the field text object text is flowed into the object by setting
the path to the element of data to be printed (this is called the "XML path") .

The Runtime Engine bundled with XSL Report Designer then takes the XML file to be printed and the project
file that describes the desired layout and generates XSL-FO. Within the generated XSL-FO the static text object
in the layout now becomes a block object (fo:block). As for the field text object, the content of the element specified
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by "XML path" is also output as the content of a block object (fo:block). The resulting XSL-FO file is then input
to XSL Formatter or AH Formatter to produce the final print and PDF files.

It's important to note that the tree structure of the XML data is reflected in the XSL-FO that the Runtime Engine
outputs. The main repeat element is outputted in XSL-FO along with subordinate elements in the XML tree. This
process is repeated based on the number of times the main repeat element appears in the XML data.

7.1  Using a XSL stylesheet

XSL Report Designer can generate a XSL stylesheet from the project file.

When a XSL stylesheet is generated from the project the XML data and the XSL stylesheet are then submitted to
an XSLT processor. The XSLT processor then outputs XSL-FO. The properties in the XSL-FO are the same as
those generated by the Runtime Engine, but the use of XSL stylesheet has certain limitations such as not being
able to use the calculation expressions set by the project file of XSL Report Designer.
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8 Object
The following are the diffent kinds of Objects supported by XSL Report Designer:

■ document object

■ report-header

■ report-footer

■ repeat object

■ page object

■ frame object

■ label object

■ text object

■ image object

■ barcode object

■ table object

■ caption object

■ column-info object

■ table-header/table-footer object

■ table-body object

■ table-row object

■ table-cell object



10

■ line object

The next section explains the most important objects. Please refer to the section on "Object and Property"（page
129 ), in the chapter "Setting of project and object" and the chapter "Objects for layout"（page 162 ) for detailed
information about each object. (Note: In the following explanations the word "object" is omitted when the meaning
is clear.)

8.1  Document and Repeat Objects

The document object is the highest level object and contains the entire report to be printed. The entire tree structure
is contained within the document object, which is the root of the tree.

The repeat object corresponds to that part of the XML data that is repeated in the print layout of the report. For
instance, the page corresponds to the repeat object when each one of the records in the data is output to one page.
In XSL Report Designer the repeat object is put directly after the document object in the structure. This is then
the main repeat of the project. Fixed, flow and label layouts can only have one Main repeat object. In Fixed and
Flow layouts the main repeat is the only repeat object. Here you would associate the path of the main repeat to
the main repeat element in the tree structure of the XML data. When the report is formatted the main repeat object
and its subordinate objects will be repeated based on the number of times the main repeat element is in the XML
data.

Flow type layouts can have multiple repeat objects put in subordinate positions to the main repeat. These are
called sub repeat objects. The following figure illustrates the relationship of sub repeat elements within the XML
data to the formatted page.

8.2  Tables

With Report Designer it is also possible to flow the repeating elements of the XML data to a table within the form
by using the table object. The following is an output example of a table where the rows correspond to the repeated
elements, and the cells of each row are set to output the children elements of the repeated element. The number
of rows in the table is the same as the number of repetitions of the data to print.
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9  Properties
"Property" is the display style, print attributes, characteristics, etc. of how objects are treated in the print layout.

For instance, the property(ies) of a text object can be the position on the page (X Y coordinates), the width and
height of the object, the font, fontsizes, the character styles, the character decorations, color etc.

The Properties that can be set differ according to the object. Please refer to "Properties list"（page 206 ).
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The purpose of this chapter is to actually guide you through the process of using XSL Report Designer to create
a Project from XML data and then generate PDF!

10  First Step
This tutorial is based around a very simple XML file that we are going to create a project file for, preview the
layout in XSL Formatter or AH Formatter and then finally output a PDF file. For the tutorial you will have to
have XSL Formatter V4.0 or later, or AH Formatter V5.0 or later installed in order to preview and format the
layout.

10.1  XML file structure

We will use sample XML data "sample-bib.xml" (included with XSL Report Designer) that makes up a very
simple book list. The content of the file is as follows.

<?xml version="1.0" encoding="UTF-8" ?>
<bib>
 <bibinfo>
    <title>
      XSL Report Designer Sample
    </title>
    <date>
      December 6, 2004
    </date>
 </bibinfo>
 <book year="1994">
    <title>
      Arabic typography
    </title>
    <author>
      Huda Smitshuijzen AbiFar?ｓ
    </author>
    <publisher>
      SAQI Books
    </publisher>
    <price>
      35.95
    </price>
 </book>
 <book year="1992">
    <title>
      The Story of Writing
    </title>
    <author>
      Andrew Robinson
    </author>
    <publisher>
      Thames &amp; Hudson
    </publisher>
    <price>
      19.95
    </price>
 </book>
 <book year="2000">



Getting started - A Tutorial

15

    <title>
      XML Handbook 5th Edition
    </title>
    <author>
      Charles F. Goldfarb, Paul Prescod
    </author>
    <publisher>
      Prentice Hall
    </publisher>
    <price>
      49.99
    </price>
 </book>
 <book year="1999">
    <title>
      XQuery Kick Start
    </title>
    <author>
      James McGovern, Per Bothner, Kurt Cagle, James Linn, Vaidyanathan 
Nagarajan
    </author>
    <publisher>
      SAMS
    </publisher>
    <price>
      34.99
    </price>
 </book>
</bib>

The following figure shows the tree structure of this XML data. The root element is "bib." "bibinfo" and "book"
are child elements of "bib" and "book" element is repeated according to the number of books listed in the XML
file. In the structure "title," "author," "publisher" and "price" appear in this order as child elements of "book." All
elements from "title" to "price" contains only text in their content.

10.2  From startup to PDF

Let's first practice by outputting the content of the "title" elements of the book list (XML data) to the PDF. First
of all, start XSL Report Designer. The following initial screen is displayed.



16

Choose New project from File menu.

In making a new project, the New Project Guide of XSL Report Designer guides you through the initial steps
necessary to set up the project. The New Project Guide has 3 pages.
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[1/3] First select what type of data the input file will be; "From XML data file" or "Create XML data file and
layout from TSV/CSV data file." This is the data file structure that XSL Report Designer will expect for the
project. The sample file we are using is an XML data file. Please check "From XML data file."

[2/3] Next, the wizard requests that you select the Layout type (Fixed, Flow or Label) for the report. Here, choose
"Fixed type."

[3/3] Next we need to specify the XML data file that we will be formatting with the Project we create. We will
specify "sample-bib.xml" for the "XML file that refers to structure." In addition the wizard requires that you
specify the "Repeat XML path" here. The Browse button will show the tree structure of "sample-bib.xml." Choose
"book" element for "Repeat XML path."
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Close the dialogue by selecting the OK button. Complete the wizard by selecting the Finish button. This will use
the default setting for the other items on the page. The screen to design the layout starts.
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Let's first output the "title" of the books to the report. Because the content of "title" element is text, we need to
insert a text object. Open the Object menu of XSL Report Designer, and choose New text. Notice that in the icon
bar below the menu bar the icon for new text is now highlighted.

Next, put the mouse on the canvas at the center of the screen, click and hold the left mouse button at the base
point of the area rectangle to be drawn for the text object (top left corner).
Move the mouse to lower right while still holding the left button down.
Release the left button when you have the rectangle for the text the size you want.

The rectangle should look like the one on the canvas below.
The canvas represents the entire page or piece of paper. The dotted lines delimits the body of the page. The areas
outside the dotted lines are the page margins .
The text object we created above should be in the body area of the canvas.
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At this point the text box is empty. Next, we will set the content that outputs in the text box. First click in the text
box to make sure that it is selected. Moving to the Properties window on the right side of the canvas click on the
right edge of the empty cell to the right of the "XML path" property with the mouse. The following is shown.

When the same place is clicked again, the tree structure of the XML data file is displayed.
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To output the content of the "title" element in the text object we just created choose "title" on the tree of the XML
data. Then push the OK button. The dialogue will then close and the "title" will be placed in the XML path cell
as the property. Be sure that the value of the cell of the "Kind" under that has changed to "Field" at the same time.

Moreover, the information of "a:title" is now displayed in the rectangle of the text object on the canvas. If the
Show sample from XML path command in the View menu is checked, the character string "Arabic typography"
that is the content of the pertinent element of the reference XML data is displayed in the rectangle of text object
instead of "a:title."
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The next step is to convert the content of the XML data into XSL-FO, preview in the GUI of XSL Formatter or
AH Formatter and finally generate PDF. XSL Formatter V4.0 or later, or AH Formatter V5.0 or later must be
installed on your system for both the preview and to generate PDF.

Choose the XSL-FO output and preview command from the Project menu of XSL Report Designer.

Because the project file has not yet been saved, a dialogue box to save the project file will be displayed. Save the
project by applying a file name. The extension is ".rxl."
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Next, the "XSL-FO output and preview" box will open. Set the path to the input XML file (for the tutorial this is
the "sample-bib.xml" file) and to the output XSL-FO file. To preview the output push the "Do preview" button.

The following dialogue appears.

First, XSL Report Designer starts the Runtime Engine and using the project file converts the input XML file to
XSL-FO. The Runtime Engine might take time to execute because it has to start VM of JAVA etc. Next, XSL
Formatter or AH Formatter is started, and XSL-FO is formatted. Again, it might take a little time to execute the
preview the first time due to the process of starting of XSL Formatter or AH Formatter. Subsequent previews are
much quicker. In a normal production environment these processes would be executed very quickly on a server.

At this point "Arabic typography," the title of the first book is displayed on the preview screen of XSL Formatter
or AH Formatter. With the current project file the "title" element of each "book" will be displayed on a new page.
The sample-bib.xml file contains 4 books entries, thus 4 pages were created.
By pushing the PDF button on XSL Formatter's icon bar or AH Formatter's icon bar a PDF file will then be created.
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The following is the PDF that XSL Formatter or AH Formatter generated.
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How was it? I'm sure you found this to be a lot easier than trying to program an XSL stylesheet.

10.3  Making of table

Next, using the same XML data of the book list let's make table in the report.

Format of this table is as follows:
(1) One line for the header.
(2) The information for each book will be output to one line in the table body.
(3) There will be 4 columns of information for each book (title, author, publisher, and price).

First, choose New project in the File menu of XSL Report Designer.

Choose "From XML data file" and click on the Next button.



26

Select "Flow type" for the layout. Click Next.

Specify "sample-bib.xml" for "XML file that refers to structure" in the New project guide, the same as we did for
first example.
Specify root element "bib" for "Repeat XML path." This will make the entire XML data output to one table of
the report.
Click Finish.

To create a new table, choose New tablefrom  Object menu.
Next, select the "frame" by clicking on it in the Objects tree window as shown in the following. When "frame"
has been selected, a light blue line is displayed under the canvas.
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To make a new table in the canvas, choose New table from the Object menu. Now draw a rectangle on the canvas
the same as we did for the text object.
Once the rectangle is drawn the following "Table setup" dialogue will be displayed.

Set "Repeat XML path" of the table in the "Table setup" dialogue by specifying the "book" element. This element
corresponds to one row of the table.
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Choose "Variable" for the "Table type" in the same dialogue. Variable means the number of rows of the table
expands according to the amount of data.
Specify 4 for the number of columns.
Because we want to apply a header row to this table, be sure "Header" is checked.
Click on the OK button.

At this point a table object containing two lines and four columns is automatically placed on the canvas.
Now we will set the output contents of each of the empty cells.

The first line is the header line. We will input the static character using XSL Report Designer by double-clicking
in each of the cells with the left mouse button and then typeing. From the left cell type "Title," "Author,"
"Publisher" and "Price."
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The second line is where we will set the output for the content of the XML data.
Starting at the first cell select the cell by clicking on it.
Then double-click the right edge of the blank cell's "XML path" property in the Properties window in order to
display the dialogue box to specify the "XML path" for the cell.
Choose the element to output to the data cell. Set "title," "author," "publisher" and "price" element sequentially.
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After all the XML paths have been set the following is displayed on the canvas. When the Show sample from
XML path command in the View menu is checked, the sample text is displayed in each cell.

When the XSL-FO output and preview command in the Project menu is executed at this stage, the completed
table will appear in the preview window of XSL Formatter or AH Formatter as follows.
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Let's adjust some of the layout here. First we will increase the width of the author column. To adjust the width of
a column, set the cursor on the left or right border of the column and when the shape of the cursor changes to the
width tool, click-and-hold the left mouse button and drag the border in the direction you want to adjust the width
to. Once you release the left mouse button the column with will be set. Now adjust the widths of each of the
columns so that they look like the following image.

Next, we will apply a background to the header. First of all, in the Objects tree window click the table-row under
table-header. This will choose the entire line. In the Properties window Double-click on the right edge of the
Background color. This will display the Background color dialogue. Check "Enable." Click the Select button to
display the "Color" table. Select the desired color. Click "OK" and "OK." That was easy.
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Because this table does not have lines between rows it is difficult to follow each book entry. Next we will draw
a line under each row. First of all, in the Objects tree window click table-row under table-body to select the entire
row. Next, in the Property menu choose Border.

When the "Border setup" dialogue is displayed, check "Individual" and choose Bottom and Solid in the "Style."
Click "OK" and "OK."
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The table object on the canvas will now look like this.

Now when you do the preview the report will look like this.
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With XSL Report Designer taking XML data and placing it in a table is easy. Adjusting the table layout is also
very easy. All the table layout adjustments are available either through the Property and Table Menues or the
Properties Window. This includes properties such as cell padding, font selection and vertical and horizontal
alignment within a cell. Now try some of these by yourself.

11  Layout design with a sample file
Now that we understand the basics let's design a layout of a more complex report. For this we will use another
Sample file included with XSL Report Designer.

■ Sample XML file : "Sample-data.xml"

The overall tree structure of this sample XML file is as follows: There are two repetitions in the XML tree. The
first is the "order-info" which corresponds to one order. This contains the elements "order-date," "requester" and
"order." The "requester" contains elements for the customer information. The "order" brings the content of the
order together. There is "order-list" under "order" which is the second repetition element. The "order-list" contains
information on the products being ordered and the quantities be ordered "count" .
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Now, let's make the "Order Form" from the XML file.

■ The sample file order-fix.fo is the finished "Order Form" and can be displayed with XSL Formatter or AH
Formatter.
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11.1  Designing the report

The "Order Form" consists of a report header, the sales order text as the body, and the report footer. The page
header and page footer appears on each page of the form.
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For this project XSL Report Designer will be used to combine, arrange and layout four kinds of objects in the
project file. They are:

■ Text

■ Image

■ Table

■ Line

Those objects are shown on the layout pane of XSL Report Designer as follows.
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New project window
To make the new project follow these steps: (Note: Screens that have previously been explained have been omitted
here.)

From the File menu select New project.
Choose "From XML data file."
Specify "Fixed type" for layout type because for this report one page will be printed per order.
For the "XML file that refers to structure" we will be using "Sample-data.xml."
For the "Repeat XML path" select the "orderinfo" element in the tree structure display. This will setup "orderinfo"
as the first Repeat XML path for the report.
Click the OK and the Finish.
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Setting the header and footer
We are now ready to layout the report. Choose "Header/Footer" from the Structure menu.

In the "Header/Footer setup" dialogue check all items; Report header, Report footer, Page header and Page footer.
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When the OK button is pushed the canvas will now contain layout areas for the Report header, Page header, body,
Page footer and Report footer.
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Set the XML path for the Page Header text object
The design of this report calls for each page to have a header with the customer name aligned left. The tree structure
of "Sample-data.xml" is displayed on the left side of the screen in the Reference XML structure window. Once a
text object is placed on the canvas a shortcut to defining the path is to click on the object in the Reference XML
structure window and then drag it onto the text object on the canvas.

Now place a text object in the Page Header area and then drag the "name" element (customer name) from the
Reference XML structure window and drop it on the text object.
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Also, if you place and the select the text object you can choose the element for the customer name from the window
that shows the tree structure of "Sample-data.xml" when the "XML path" property is clicked in the Properties
window.

Inserting an expression (XPath) for a text object
For this text object in the header we want to have "To" displayed before the customer name. This can be set using
the XPath expression. When "Expression" property is clicked in the Properties window the "Expression" dialogue
is displayed.

Choose "XPath()" from the function list and double-click the left mouse button. This will put "XPath()" in the
edit box of the expression. Now complete the expression by typing "To:" +XPath("requestor/name").

Inserting an image object
Next we will arrange the company name and logo on the right edge of the page header. Use image object to insert
the logo. Set "Image type" to "BITMAP" in the Properties window. Set the "File path" to where the picture file
is for the logo.



Getting started - A Tutorial

43

Place a text object above the image and then type the Company name in that.

The Page header is now finished.

Laying out the body area
The next step is the body area. First of all, input the title of the report (Order Form) and the company name. Let's
arrange those by using text objects.

Inserting table objects
For the form we will us tables objects for the customer name and address and order details.

■ Customer Name and Address: Table with a caption and one line
Choose New table from the Object menu and draw a rectangle on the canvas. This will open the "Table
setup" dialogue. Specify one row and one column and a caption above. No Header and No Footer.
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Input the static text "Customer;" in the caption cell. Set the font style to Bold italic and underline. Set
Background color of the entire table, and embed the customer name from the element of XML file under
the main body of the table. As well as with the page header, you can drag and drop "name" from the
Reference XML structure window in order to set the "XML path."

■ Table with multiple rows
Next, we will make a table for the Order Statement. Again, choose New table from the Object menu and
then set the position and the following in the "Table setup" dialogue.
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Set the element allocated for the "Repeat XML path" of the table. Here, specify the "order/order-list"
element. This element contains the details of the order.

(Note: Table columns can contain either text, images or barcodes. The content of the columns is set through
the Table / Setting menu, Column Setting Tab or by selecting the column in the table and then setting the
Column type in the Properties window.)
Insert objects (text and image) into each column of the table for the specified number of rows displayed.

At this point in the report layout we will not total the rows our column.
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In the column for "Item" set "XML path" so that the "item-name" in the subrepetition is entered in each
cell. For the image objects the "XML path" is set to "@scr." Next set the paths XML paths for for "Unit
Price" and "Quantity." Leave the total column blank.

When the same setting is done for all lines, the following table is made.

Line object
The Line object is a convenient way to draw vertical, horizontal and diagonal lines. Lines can be solid, dotted or
dashed. The direction of the diagonal line can be specified, left-top to right-bottom and left-bottom to right-top.
Put a line object under the table to mark the end of the table.

Input the order date
Input the order date by creating a two column table. In the first column put "Date:" In the second column put the
"XML path" and expression (XPathEx) illustrated below.
XpathEx["order-date/mm"] + "/" + "XpathEx["order-date/dd"] + "/" + "XpathEx["order-date/yy"]
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Input the text for the page footer and report footer at the end.

The report design is completed! The finished project file should look like this.
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11.2  Printing and and making a PDF of the report

Save the file
Let's save the project file in two different formats, .rxl and .xsl.

■ Project File (order-fix.rxl)
Use the Save project in the File menu. The .rxl file output is the native file format for XSL Report Designer
and works only with XSL Report Designer and the Runtime Engine provided with Report Designer.

■ XSL stylesheet (order-fix.xsl)
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Use the Save XSL stylesheet in the File menu to save the project as an XSL file. The XSL stylesheet and
the XML file can then be transformed into XSL-FO by using an XSLT processor. Some of the properties
supported by the .rxl file format are not supported by the XSL stylesheet. XSL Report Designer always
works with the rxl file.

Using XSL Formatter or AH Formatter to Display the finished project
Let's now display the project using both the .rxl file and the XSL stylesheet.

■ Display with .rxl project file
This is done by executing the XSL-FO output and preview command in the Project menu. This is the same
layout of the "Order Form" we've have been working with.

■ Display with XSL stylesheet
Again, execute the XSL-FO output and preview in the Project menu, but this time check "Use XSL
stylesheet."

Displayed page 2 using XSL Formatter or AH Formatter.
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 Basic operation
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This chapter explains details in each part of XSL Report Designer and basic operations.

12  Application Window

The application window (GUI) of XSL Report Designer consists of following elements.

1. Layout Pane or Canvas

The layout pane is where the WYSIWYG design and layout of objects to be output in the report takes place.

2. Docking windows

XSL Report Designer has three docking windows surrounding the layout pane.

■ Objects tree window

■ Reference XML structure window

■ Properties window

Each window can be resized by dragging the edge. All windows can be displayed at the same time. You
can also hide the windows when they are not needed.

3. Title bar



Basic operation

53

The title bar shows the title of XSL Report Designer and the name of the project file that is being edited.

4. Menu bar

The menu bar contains the following 10 pull-down menus:

■ File

■ Edit

■ View

■ Project

■ Structure

■ Object

■ Property

■ Table

■ Window

■ Help

Some of menus can be accessed by the context menu which is displayed when the mouse's right button is
clicked in the layout pane.

5. Tool bar

The most commonly used menu functions are available as buttons on the tool bar. You can easily execute
these functions by one click of the mouse.

6. Status bar

The left side of the status bar displays the functions of the icons on the button bar as you pass over them
with the mouse. It also displays the status of XSL Report Designer. On the right side of the status bar the
current page number and information about the structure such as report header (RH) or page header (PH)
are displayed.
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12.1  Layout pane

The layout pane consists of a layout area which has a horizontal ruler on top, vertical ruler on the left edge and
scroll bars on the right edge and the bottom. In the layout pane you can input, select, cut, copy, paste, move, delete,
resize and edit text and the various objects of the design with the mouse and keyboad.

The units set for the scale of the rulers is based on the Paper settings under the Project menu /Page setup /
Customize /Paper customize. Paper sizes can be defined in either mm or inches. If the definition is in mm the
rulers will display mm and if the definition is in inches then the rulers will display inches. Page margins are shown
with a light dotted line. Inside the dotted line is the body and outside is the top, bottom, left and right margins.
The area outside the Paper size is dark gray. The size of the margins can be changed by dragging the margin line
on the ruler. This will also move the dotted lines on the layout area.

On the bottom left corner of the layout pane are plus (+) and minus (-) buttons to change the magnification of the
layout pane. Next to that is a numerical value that you can also click on and change.

 Notes for the layout pane;

1. Objects that cannot be selected with the mouse on the layout pane
The following objects cannot be selected on the layout pane with the mouse. They have to be selected
from the Objects tree window.

■ document object

■ repeat object

■ table-header/table-footer object
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■ table-body object
2. Margins on the page are not displayed for the following:

■ Frame object in Flow type.
Because the final Frame object's position on the paper cannot be specified within a Flow the top
and bottom margins are not displayed.

■ Label object in Label type.
In a Label all objects exist inside the margins therefore no margins are displayed.

■ Header/Footer
Top and bottom margins of report-header, report-footer, page-header and page-footer are not
displayed.

3. Header and Footer in Label type
The right and left margins within the Header and footer of a Label cannot be changed on the layout pane
with the mouse.

12.2  Objects tree window

The Objects tree window provides a hierarchical
structure view of all objects in the layout pane.
Through the Object tree window objects can be
selected, cut, copied, deleted and pasted. Frames and
repeats can be inserted and moved in the tree.
The object tree functions the same as a general tree
view in Windows. Object that cannot be selected on
the layout pane such as the document object and
repeat objects, etc. can be selected in the Object tree.
Selecting a target object in the object tree will
highlight those objects as selected in the layout pane.

Object tree Tool bar

The tool bar at the top of the Objects tree window
provides buttons to "Update" (refresh the view),
"Insert repeats," "Insert frames (page)" and "Move
repeats or frames up and down in the structure."
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12.3  Properties window

The Properties window is where the
attributes are displayed, can be set and
changed for objects selected in the layout
pane. The list of properties displayed
depends on the type of object selected.
Please refer to "Properties list"（page
206 ) for more information about the
various properties.
The relevant properties for a selected
object are divided into multiple categories
of information about the object and then
displayed in the Properties window. Each
category shows the properties and their
values within that group.

1. Properties
Each Property that can be set for the
selected object is shown.

2. Value
Each Value which can be specified
for the property. To add or change a
value click in the cell for that value.
Property values such as fontsize,
width, height and so on are
displayed in their relevant units of
measure.

You can choose to expand or collapse the
contents of an individual category within
the Properties window. At the bottom of
the properties window an explanation of
each property is displayed as the property
is selected in the Properties window.
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12.4  Reference XML structure window

The hierarchical structure of the reference XML data
being used for the project is displayed in the Reference
XML structure window.
From the reference XML structure the following can
easily be set:

■ The XML path by dragging and dropping the
element onto the object in the layout pane.

■ The XML path in an expression by clicking the
element to be inserted into the expression.

■ Insert text fill.

Set XML path by dragging and dropping of element
The Reference XML structure shows a tree view of the data that was specified during the project setup. The XML
path of an object in the layout pane can easily be set by dragging and dropping an element from the tree to the
object.
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Set XML path in the expression by clicking on the element
The XML path and the variable name can be put into an expression by clicking the element in the tree or the object
that specifies the variable name.

Either the full or the relative XML path, according to the situation, can be inserted. To insert the full XML path,
hold down the [Ctrl] key and click the element.

13 Menu bar

13.1  File

The File menu contains the following functions.
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Menu Description

New project Makes a new project file. Sets the necessary items with the New project
guide.

Open project Opens an existing project file. An error message box is displayed if the selected
file is not a valid XSL Report Designer project file (.rxl) and the file opening
process is then discontinued.

Close project Closes the active project file without exiting the program. If the project has
been saved since the last edit then the window closes immediately. If the
project has not been saved since the last edit, then you will be prompted as to
whether to save the changes to the project.

Save project Saves (overwrites) the active project file. The first time a project is saved you
are prompted for a project name. Subsequent saves will overwrite the
previously saved project file.

Save project as Saves the active project file with a new name by opening the Save As window
so that a new file name can be assigned.

Save XSL stylesheet Saves the current project file as an XSL stylesheet.

Preferences Opens a dialogue box to set application environment Preferences and how tool
tips and other information are displayed on the screen. These settings are
independent of the individual projects.

Exit Quits XSL Report Designer. If there is an open project has not been saved
since the last edit, then you will be prompted as to whether to save the changes
to the project.

New project guide
In XSL Report Designer when you select New Project a New project guide that consists of 3 pages will open up.
The New Project Guide will then take you through the initial steps necessary to set up the project.

New project guide [1/3]

[1/3] First select what type of data the input file will be; "From XML data file" or "Create XML data file and
layout from TSV/CSV data file." This is the data file structure that XSL Report Designer will expect for the
project.
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■ From XML data file
This is an existing XML data file that will then be referenced in the XML structure window as you make
a project.

■ Create XML data file and layout from TSV/CSV data file
An existing TSV (Tab Separated Values) or CSV (Comma Separated Values) file is considered to be a data
file where the records are then queued up and an XML data file is automatically generated by XSL Report
Designer based on the TVS/CSV file. The resulting XML data file is then used as the reference XML
structure for the project file.

New project guide [2/3]

[2/3] Next, the guide requests that you select the layout type for the report.
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■ Layout type
XSL Report Designer has three layout types to select from. These are:

1. Fixed type
2. Flow type
3. Label type

When a TSV/CSV file is the source the layout is always a Flow type.

■ Data items
Specifies how to display each line when using a TSV/CSV file. This setting controls how the default layout
of a project is automatically made.

If "to be Table" is selected
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A table will be made from the TSV/CSV data in the project where one line of data equals one row of
the table. (Output example（page 127 ))
If "to be List" is selected
A list will be made from TSV/CSV data in the proejct where one line of data equals one record in the
list. (Output example（page 127 ))

New project guide [3/3] (For the use of XML data)

[3/3] Specifies the XML data file that will be used as sample data for formatting with the Project. In the XML
path the repeat element for the report is specified. Paper size and page orientation are also selected on this page
of the New project guide.

■ XML file that refers to structure
Set the path to the XML file you will use as sample data for the project. The Browse button opens the
dialogue for the file list.
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■ Repeat XML path
Specifies the path to the main repeat element in the XML data. When you print or generate PDF from XML
data the number of reports created will be equal to the number of times the main elements appears in the
data.

■ Number of pages at each repetition
Only available for the Fixed layout type. You can specify the number of pages produced by each record.
For instance, for each record you can specify that the front cover is the first page and details are on the
second page. In this case each record would produce two pages and the specified number of pages would
be two.

■ Paper
Here you can select from predefined paper sizes through the pull-down menu. You can also create custom
paper sizes through the Project / Page setup menu. Custom paper sizes become available through the pull-
down menu.

When the XML path and the Repeat XML path are not specified here, the following message is displayed. They
can be specified later through the Project setup dialogue in the Project menu.

New project guide [3/3] (For the use of TSV/CSV data)

When TSV/CSV data file is selected as the data source, the XML file that refers to the structure is automatically
created from the TSV/CSV file.

■ TSV (tab separeted)/CSV (comma separated) file
Set the path to the TSV/CSV file you want to use. An XML data file is generated automatically based on
the TSV/CSV file specified here. The Browse button opens the dialogue for the file list.

■ Character set (code page)
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Here is where the character set/language used for the TSV/CSV is specified. Generally Latin 1 is common
in Western Europe. Japanese (shift JIS) is common in Japan. If a code page for special characters is used
it can be selected here. The XML file that is created from the TSV/CSV data is converted into UTF-8.

■ Data XML file
Specify the place to save the XML file generated from TSV/CSV file automatically. A default file name
is automatically set, but you can change it.

Preferences dialogue

Tooltip

When the mouse is stopped on an object the tooltip for the object is displayed. The tooltips are displayed for the
targets checked here.
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Misc

■ Barcode option's directory path
Set the path for the directory of XSL Formatter Barcode Option or AH Formatter Barcode Option. This
setting is used when barcode objects are contained in a project file saved as an XSL stylesheet.

■ Show sample from XML path default
When this is checked the data content and attributes of elements from the first main repeat of the XML
data will be displayed in the objects in the project on the layout pane (Show sample from XML path). This
value can be changed in the View menu while project is being edited.

■ Return scroll position and magnification
When selected XSL Report Designer saves the scroll prosition and magnification for a project and then
restarts at the saved settings.

■ Preserve window layout
When checked XSL Report Designer starts with its various windows in the same position they were in
when XSL Report Designer was exited. If unchecked then XSL restarts with the docking windows in the
default setting.

13.2  Edit

The Edit menu contains the following functions.

Menu Description
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Undo Cancels the last operation.

Redo Cancels the last undo action.

Cut Removes the selected object and places it on the Clipboard. Table-columns
and table-lines can be deleted but not cut.

Copy Copies the selected object and puts it on the Clipboard.

Paste Pastes the object from the clipboard.

Clear Deletes the selected object without putting it on the clipboard.

Stick When the apical positions of the object and the other object are close to each
other while dragging the object, they stick to each other automatically so that
their apical positions may become the same coordinates. It behaves like a
magnet. The stick function cannot be used when the grid is effective.

Select Parent The parent object of selected object is then also selected.

Select Sub.Objects The subordinate position object of selected frame and table is selected on the
Select subordinate objects dialogue.

Insert text fill XML path can be set between text and text in the text object in order to insert
variable data. Multiple XML paths can be arranged.

Select last modified object The last modified object (such as changed Properties) is selected.

Select subordinate objects dialogue

It is convenient to change multiple objects all at once. The objects that can be selected are text, images and
barcodes.

Insert text fill
Multiple XML paths can be arranged to input text in a text object. An example of this would be where a name
and member number were inserted in the body of a letter.

To use this function, put the cursor in the text object where you want to insert the data from the XML path and
then choose "Insert text fill" from the Edit menu.
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13.3  View

The View menu contains the following functions.

Menu Description

Objects tree Displays the Objects tree docking window.

Properties Displays the Properties docking window.

Reference XML structure Displays the Reference XML structure docking window.

Standard When checked the standard tool bar is displayed. When unchecked the
standard tool bar is switched off.

Object When checked the Object tool bar is displayed. When unchecked it is turned
off.
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Arrange When checked the Arrange tool bar is displayed. When unchecked it is turned
off.

Status bar When checked the Status bar is displayed. When unchecked it is turned off.

Magnification By clicking on Magnification you can then select to zoom "Up" (increase the
magnification), zoom "Down" (reduce the magnification), "Fit to window
width" (fits the page width to the width of the layout pane) and "Set" the
magnification to a user specified percent.

Grid Opens the Grid dialogue. Both horizontal and vertical grid lines are turned on
within the layout pane. Grid lines are non-printing and are used to measure
and arrange objects.

Show sample from XML path When this is checked the data content and attributes of elements from the first
main repeat of the XML data will be displayed in the objects in the project on
the layout pane.

Grid dialogue
Both horizontal and vertical grid lines can be turned on within the layout pane. Grid lines are non-printing and
are used to measure and arrange objects.

Show grid;

The grid settings can be specified in the Grid dialogue.
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■ Snapped to grid
When it is checked you can snap to the grid to make, move or resize objects. The size of grid is set in the
Grid size. The Grid does not have to be displayed for Snapped to grid to work.

■ Show grid
When it is checked the grid is displayed. When unchecked the grid is not displayed. The grid size for display
in the layout pane is set in the Grid show size.

Show sample from XML path
When this is checked the data content and attributes of elements from the first main repeat of the XML data will
be displayed in the objects in the project on the layout pane.

This is the sample data displayed in the Reference XML structure window.

When "Show sample from XML path" is not checked the XML path will be displayed in the object.
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13.4  Project

The Project menu contains the following functions.

Menu Description

Project setup This starts the Project setup dialogue where properties concerning the project
setup are set.

Page setup This opens the Page setup dialogue for setting the page properties.

XSL-FO output and preview Produces XSL-FO by transforming the reference XML data using the project
file and then formats the XSL-FO with XSL Formatter or AH Formatter so
that it can be previewed. The XSL-FO output and preview dialogue also is
where necessary information is set of output and preview.

Project setup dialogue
This is where selected Properties concerning the project settings can be set and changed.
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■ Layout type
The layout type set when a new project file is initially set up is displayed. It cannot be changed.

■ XML file that refers to structure
Here the XML file that refrers to structure of the data file is specified.
By setting this the tree view of XML file can be displayed when the XML path is to be set. You can easily
select XML paths (elements) from the tree view. The Browse button opens the dialogue for the file list.

■ Repeat XML path
This is where the data position in the XML path start repeating to generate a new report is specified. Clicking
the Browse button opens XML path dialogue of the XML file set above in the "XML file that refers to
structure." You can then easily select the repeat from that view.

■ Number of pages at each repetition
This specifies how many pages are used for one record. This is effective only for Fixed type layouts.

■ Default font
The default font used with the project file is set here. When the Select button is clicked the Font dialogue
opens so that the font family, style, size and effects can be selected.

■ Project comment
The comment character string can be freely described as it has no effect on the project or the print results.

Page setup dialogue
Through this menu Properties concerning the page setup are specified.
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■ Paper
This is where the paper size is specified by selecting the paper from the combo box of "Paper." The size
of width of paper is displayed in "Width" and the height of paper is displayed in "Height." A4 and B5 paper
sizes are the default sizes. Clicking the Cusomize button opens the following Paper customize dialogue to
define and add the new paper sizes.
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■ Definition list
This displays the list of paper sizes that have already been defined. To change the settings of a defined
paper select the paper and change the values displayed to the right. When finished click the Change
button to save the changes.

■ Name
Input the name for the defined paper type.

■ Width
Input the width of the paper.

■ Height
Input the height of the paper.

■ Measure
The unit of measure used for the defined paper is selected from the combo box. The units that can
selected are mm (millimeter) and in (inch).

■ Add
Click the Add button to save the settings when you finish setting each value a new paper definition.
Uniques names are required for each paper definition.

■ Change
Click Change to save changes to existing paper definition values.

■ Delete
Deletes a paper definition. Select the definition to be deleted and then click on the Delete button.

■ Orientation
This sets whether the page prints "Portrait" or "Landscape."

■ Margin
Sets the top, bottom, left and right margins for the paper. The Margins use the same unit of measure as the
paper size.
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■ Divide
When the layout type is set as Label type the number of labels of rows and columns in the paper is set.

■ Labels down
This defines how many vertical units/rows the page is divided into.

■ Labels across
This defines the number of horizontal units or columns the pages divided into.

■ Horizontal pitch
This is space for labels across.

■ Vertical pitch
This is space for labels down.

■ Printing direction
This defines the direction data is printed on the labels. "Left to right" is the movement of left to right
printing columns and then move to the next row. "Top to bottom" is the movement of top to bottom
printing rows and then move to the next column.

XSL-FO output and preview dialogue
For XSL-FO output and preview the Runtime Engine processes the sample XML data used for the project with
the project file. Once XSL-FO is generated it then executes XSL Formatter or AH Formatter. XSL Formatter or
AH Formatter renders the XSL-FO and displays it on the preview screen. If the project file has not yet been saved
the Save dialogue is displayed before the XSL-FO output and preview dialogue is opened.

■ Project (layout) file
This is where the name of the project (layout) file is displayed.

■ XML file
The XML data file that is referred for the output and preview. The Open button opens the dialogue for the
file list.
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■ Create XSL stylesheet file
When checked a XSL stylesheet is created and then used to make the XSL-FO file. An XSLT processor is
required to convert XSL-FO from XML file and XSL stylesheet. Please refer to the online manual of XSL
Formatter or AH Formatter for details on setting up the XSLT processor environment.

■ Save XSL stylesheet as:
Specifies the XSL stylesheet used for conversion. The Browse button opens the dialogue for the file list.

■ Save XSL-FO file as:
This is where the name of output XSL-FO file is set. The Open button opens the dialogue for the file list.

■ Label start position
When the layout type is Label sets the position on the paper (across and down) where the first label will
begin to print.

■ Execute new application instance
When checked a new copy of XSL Formatter or AH Formatter will be started.

■ Do preview
Creates the preview by converting the XML data to XSL-FO using the project file and then if there are no
errors starts XSL Formatter or AH Formatter.

■ Setting only
Saves changes to the settings without doing an output and preview.

■ Cancel
Cancels any changes and closes the XSL-FO output and preview dialogue.

13.5  Structure

The Structure menu contains the following functions.

Menu Description

Header/Footer The Header/Footer setup dialogue specifies whether project file will have a
header and/or footer for the page and/or for the report.

Insert repeat Inserts repeat object.

Insert frame (page) Inserts a frame object in the layout for Flow type or page object for Fixed type.

Move repeat or frame Moves the position of repeat or frame (for Flow type) object.
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Header/Footer setup dialogue

This dialogue is used to turn on or off report header, report footer, page header and page footer in the layout. If
you want to delete a header or footer, display this dialogue and remove the checkmark.

Insert repeat
Flow type layouts can have multiple repeat objects under the main repeat. Repeat objects can only be inserted in
a position that is subordinate to the main repeat or frame object. It can be before or after other repeat objects.
From the Objects tree window choose the object where you want to insert the repeat. Then choose insert repeat.
Fixed type and Label type layouts can only have a main repeat object, thus the insertion of repeat object is grayed
out and not available.

"Insert before" inserts a new repeat before the selected repeat or frame. "Insert after" inserts a new repeat after
the selected repeat or frame. "Include self" inserts the repeat that includes the selected repeat as child to original
position.
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Insert frame (page)
When the layout type is Fixed a new page object can be inserted before or after the existing page object. (Insert
page) The position where the repeat object can be inserted can only be subordinate to the main repeat. Select the
object subordinate to the main repeat from the object tree and then insert page.

When the layout type is Flow type a new frame object can be inserted before or after an exsiting frame or repeat
object other than main repeat. (Insert frame)

"Insert before" inserts a new page/frame before the selected page or repeat or frame. "Insert after" inserts a new
page/frame after the selected page or repeat or frame.

This function is not available for Label type.
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Move repeat or frame
The position of the repeat or frame (for Flow type) can be moved. (Move repeat or frame) "Up" moves the selected
repeat or frame to the front of the previous repeat or frame. "Down" moves the selected repeat or frame below
the repeat or frame behind.

13.6  Object

The Object menu contains the following functions.

Menu Description

Select The object is selected.
When checked multiple objects are selected by dragging of the mouse on the
layout pane while holding down the left mouse button. Individual items are
selected by clicking on them.

New text New text object is drawn by dragging the mouse on the layout pane when this
menu item is checked.

New image New image object is drawn by dragging the mouse on the layout pane when
this menu item is checked.

New barcode New barcode object is drawn by dragging the mouse on the layout pane when
this menu item is checked.

New table New table object is drawn by dragging the mouse on the layout pane when
this menu item is checked. After creating the table object the Table setup
dialogue is displayed. The final positon of the new table object is determined
by moving the table with the mouse after the Table setup is completed.

New line New line object is drawn by dragging the mouse on the layout pane when this
menu item is checked.

Autofit Multiple objects can autofit (align and size) at a specified position relative to
either a priority object (the last object selected), the frame, the margin or the
paper. In "relative to Object" the object size can be specified as the same size
as the priority object.

Arrange Controls the arrangement of the object front or back. In the Flow type layout
arrangement only effects objects within the same frame. "Front" brings the
selected object forward and "Back" sends it backwards.

Group Combines multiple objects into a group so that the objects are treated as a
single unit.
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Ungroup Returns the entire object to a correction of multiple objects.

Autofit
Multiple objects can be arranged at a specified position relative to a priority object, the frame, the margin or the
paper. In "relative to Object," the object size can be specified as the same size, "width"/"height"/"both" as the
priority object.

Objects are arranged in the position specified.

Select multiple objects and specify if they are to be relative to object, frame, margin or paper and then select the
position.

relative to Object Alignment Left/Right/Top/Bottom Arranges objects to the left/right/top/
bottom on the basis of the priority
object.

Horizontal justified/Vertical justified Distributes selected objects in
horizontal/vertical justified.

Size Width/Height Arranges the width/height of selected
objects.

Both Arranges the size, both of width and
height, of selected objects.

relative to Frame Left/Right/Top/Bottom Arranges at the left/right/top/bottom
edge of the frame.

Horizontal centered/Vertical centered Arranges horizontal/vertical centered in
the frame.
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relative to Margin Left/Right/Top/Bottom Arranges at the left/right/top/bottom
margin position.

Horizontal centered/Vertical centered Arranges horizontal/vertical centerd in
the margin.

relative to Paper Left/Right/Top/Bottom Arranges at the left/right/top/bottom
edge of the paper.

Horizontal centered/Vertical centered Arranges at horizontal/vertical centered
on the paper.

Arrange
Controls the arrangement of the object front or back. In the Flow type layout arrangement only effects objects
within the same frame. "Front" brings the selected object forward and "Back" sends it backwards.

13.7  Property

The Property menu contains the following functions.

Menu Description

Kind The kind of data can be either "Field" or "Static." When "Field" is selected for
text, image and barcode objects the data from the specified XML path will be
embedded.

Border The border of frame around an object is set through the Border setup dialogue.
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XML path Sets which element of XML data is embedded in the object that has a property
kind of "Field."

Expression Opens the Expression dialogue which then guides you through setting
expressions that can insert information such as page number and date, perform
simple and complex calculations, return values and manipulate data.

Font Opens the Font dialogue for selecting the Font, style, size and effects.

Text color Opens the Text color dialogue for setting text color.

Background color Opens the Background color dialogue for setting the background color. The
rectangular area of an object is filled with the selected background color.

Horizontal align Used to set how the content is arranged horizontally in the rectangular area of
the object.

Vertical align Used to set how the content is arranged vertically in a rectangular area of the
object.

Image Used to set how an image is treated within the rectangular area of an object.
Also used to set the path of the image file.

Rough image Provides the ability to open a non XSL Report Designer image of a form in
the layout pane to then be used as a rough image on which to layout objects.
The Rough image dialogue lets you set the path to the image file.

Property group A property group is a named collection of object properties.
With a property group in a property expression, you can change multiple
properties at once dynamically.
You can edit property group with Property group dialogue and Edit property
groupdialogue.

Border setup dialogue
Used to set the border around a frame or object.



82

■ Individual
By clicking "Left" without checking Individual you can specify the same setting for all borders. When
Individual is checked all button, "Left," "Right," "Top" and "Bottom" are available for setting the borders
individually.

■ Apply to inside all
Used for table object. When checked borders/rules are drawn around all table cells, including the header
and footer. The Left button is used to set the rule properties.

Border dialogue
By clicking the "Left," "Right," "Top" or "Bottom" button the following dialogue is opened.

■ Style
Select the style of the border from "None," "Dotted," "Dashed," "Solid," "Double," "Groove," "Ridge,"
"Inset" and "Outset."
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■ Width
Specify the width of border. The width measure can be in pt (point), mm (millimeter) and in (inch).

■ Color
Specify the border color.

Font dialogue

This is for selecting the Font settings.

Text color/Background color dialogue

■ Enable
When enable is checked the color can then be set or changed for the font.

■ Color
Color names (Red, Yellow, Cyan, Magenta, Green, Blue, Black, White) or the RGB value can be input by
the hexadecimal number (example # C0C0C0) in order to set a specific color.

■ Select
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Colors can also be set by using the following dialogues:

Rough image dialogue
Provides the ability to open a non XSL Report Designer image of a form in the layout pane to then be used as a
rough image on which to layout objects. The rough image setup menu lets you set the path to the image file. A
rough image is specified only at the "page" object (in Fixed type) from the Objects tree window.
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Rough image setup dialogue
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■ Rough image file path
Specifies the image file to use as a rough image. The Browse button opens the dialogue for choosing a file.

■ Print
When it's checked, the base draft will be outputted as a background image when printing and outputting a
PDF file.

■ Page number of PDF
When PDF file is specified as an image file, the page number of PDF used for a base draft can be specified.

■ Fit to paper
When checked the diplay of the rough image expands or contracts to fit the size of paper.

■ dpi
The dpi value of the rough image file set the size of the image within the layout pane when the "Fit to
paper" is not checked.

■ Adjust
When checked the "Brightness" and "Contrast" of the image can be adjusted. When not checked the rough
image is displayed equivalent to the original image.
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Property group dialogue

You can add a property group by clicking the Add button.
You can delete a property group by clicking the Delete button.
You can edit a property group by clicking the Edit button.
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Edit property group dialogue

Please refer to "Properties list"（page 206 ) for more information about the properties.

13.8  Table

The Table menu contains the following functions.

Menu Description

Column For selected column(s), inserts new column right or left, cuts the column and
make columns the same width with Autofit.

Row For selected row(s), inserts new row above or below, cuts the row and makes
rows the same height with Autofit.
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Caption Inserts or erases a caption on top or bottom of a selected table.

Header Inserts or erases the header for the selected table.

Footer Inserts or erases the footer for the selected table.

Setting Opens the Table setup dialogue for changing table properties.

Merge Cells Merges two or more adjacent cells into a single cell and display the contents
of a sinble cell.

Unmerge Cells Separates a merged cell into the original number of cells.

Table setup dialogue

Table setting tab
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■ Repeat XML path
Where the XML path to the element repeated in the table is specified. The Browse button opens the dialogue
for XML path.

■ Table type
In a "Fixed" table the number of rows do not change according to the amount of data. In a "Variable" table
the table expands to accommodate the number of rows in the XML data.

■ Caption
Specifies whether the table will have a caption and if the caption is above or below the table.

■ Rows
For fixed table specifies the number of rows.

■ Columns
Specifies the number of columns in the table.

■ Language
Specifies the Language used in the table. When formatting the table the set language controls how the data
is formatted for totals, subtotals, sub-subtotals, etc. Conforms to "language codes" defined in ISO 639.

■ Country
When formatting the table the Country information controls how the data is formatted for totals, subtotals,
sub-subtotals, etc. Conforms to "country codes" defined in ISO 639.

■ Header / Footer
Sets Whether to put a header/footer for the table.

■ Set Grouping
Grouping controls whether table cells and rows are automatically merged to create vertical spans in the
table object. "None" does not group cells. "Variable" groups and merges cells when the same data appears
in consecutive cells in the same column. "Fixed" groups the specified number of rows and removes the
border between them without merging the rows. The Group specification takes effect only when the
Break in Contorl break tab is not set.

http://lcweb.loc.gov/standards/iso639-2/iso639jac.html
http://www.iso.ch/iso/en/prods-services/iso3166ma/index.html
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Column setting tab

In the Column setting tab, the object type (Type) and the XML path (path) for each column are specified. (Column
type) Select the column in Columns list, and then select the type of object from the Type combo box. Specify the
XML path in the XML Path box. Specify the relative path from "Repeat XML path" of the table as the XML path
here.

■ Columns
Lists each column of the table.

■ Type
Object type for the selected column.

■ XML Path
The XML path to the element repeated in the column is specified by the relative path from "Repeat XML
path" of the table. The Ref button opens the tree view of XML path specified by "Repeat XML path."

■ Grouping
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Specifies whether Grouping of each column is set. The check box is available only when the "Set Grouping"
property is specified for "Variable" or "Fixed" in the Table setting tab. In addition to the "Set Grouping"
in the Table setting tab gouping for each column has to be set here for grouping to take effect.

Control break tab

Control break is a function that totals the content of cells by the specified "Column number to judge as break."
Because the total result is output to a row that does not originally exist, the Set Grouping property specified by
"Fixed" is not available for this function.

■ Setting level
Select the level of "Subsubtotal," "Subtotal" and "Total" to set each setting for control break.

■ Break
Break judges the specified columns, and outputs the total of the value of the columns. The total result is
output to the specified column of the row for the total result of the automatic insertion. Break can be
specified for each setting level. Total result is output to the columun that is specified by "Column for the
total." Input the column number here. (This is property for the table.) Specify the column number in
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"Column number to judge for break" so that the specified column becomes the break key. When the value
(content) of the column specified here has changed, the break processing is done.

■ Background color
Sets the background color for the total results row.

■ Font
Sets the font for the total results row.

■ Title for the total
Specifies the title that is output to the total results row. Which column the title is placed in is specified in
"Column."

■ Format
The numeric format of the total result row.

13.9  Window

The Window menu contains the following functions.

Menu Description

Cascade Cascades the layout pane of all open projects in the center of the screen.

Tile Tiles the layout pane of all open projects in the center of the screen.

Arrange Clicking arrange while viewing a project and then shrinking the project with
the minimize icon will exclude that project from tile and cascade till the project
is viewed again with Restore Up or Maximize. The project icons are lined up
at the bottom of the window.

13.10  Help

The Help menu contains the following functions.

Menu Description

XSL Report Designer Help Displays the Help for XSL Report Designer.

Antenna House Web Site Displays the Antenna House Web Site.

About XSL Report Designer Displays the version and copyright information for the program.

14  Context menu
The context menu is a pop-up menu displayed when the mouse's right button is clicked in the layout area. It
provides shortcuts to the most used items in the main XSL Report Designer menues.
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The context menu selections change according to the status at the time the right mouse buttom is clicked. All these
items exist in the main context menu. For details about the individual menu items refer to the main menu.

The context menu contains the following commands:

■ Cut

■ Copy

■ Paste

■ Select Sub. objects

■ Table

■ Border

■ Front (Arrange)

■ Back (Arrange)

15  Docking window
As the default XSL Report Designer displays three docking windows (Objects tree, Reference XML structure,
and Properties) surrounding the layout Pane which is the window for editing and design of the document layout.

By using the mouse you can freely move and change the size of each window in order to display information on
the screen as you want to see it.

The following section explains the method of setting the docking windows to either display or not display and
how to change their position and size.

15.1  Reset to the default setting

The following is how the default settings for the docking windows looks.



Basic operation

95

To return you display to the default settings restart XSL Report Designer without a checkmark in the "Preserve
window layout" in the Misc tab in the Preferences dialogue. Returning to default is very useful if while
manipulating the docking windows you somehow loose control of them.

15.2  Floating window mode

In floating mode, a window has a thin title bar and can appear anywhere on the screen. A floating window is
always on top of all other windows. To make a docking window a floating window, click twice on the window's
title bar. Click twice on the floating window title bar to redock the window.
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15.3  To show or hide a docking window

To hide the window

To hide a docking window click the  button in the window's title bar.
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To show the window
To show a docking window click the name of the window on the View menu.
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15.4  Layout of windows

The following operations can be freely done by using the mouse on the docking window so that you can arrange
them according to your preferences.

■ Change to a floating window

■ Change the size and the layout

■ Dock with other window

■ Hide window automatically

The following is an example to show how easily the docking windows can be moved.

Change to a floating window
To change a docked window to a floating window, double-click in the title bar of window. You can move the
floating window freely by dragging it with the mouse.

To return the window to its previous docked location, double-click the window title bar.

As floating windows are dragged around the window they will automatically try and dock as they pass over
docking areas. To position a floating window over a dock (without docking it) hold down the [Ctrl] key and drag
the window over any dock area of the application window.

Change the size and the layout

Change the size
The size of window can be freely expanded and contracted by dragging the borderline.
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Change the layout
To change the layout of the windows hold the mouse button down in the title bar of the window you want to move
and drag the window to the desired position, As the window is being dragged around the screen outlines will
appear to show how the window positions at that point in the display.

For example, to make the Objects tree window displayed along the left edge of the screen drag the Objects tree
window to the left edge border of XSL Report Designer.
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To display the Object tree at the top, drag it to the top border.
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 Tip

■ To position a docking window over a dock (without docking it), hold down the [Ctrl] key and drag the
window over any dock area of the application window. The window now becomes a floating window.

■ The position of a floating window is decided by where you moved it with the mouse and not by the
docking positions around the edge of the window.

Dock on top of other docking windows
Docking windows can be stacked one on top the other by dragging the title bar of one docking window on top
the title bar of the other docking window. When docking windows are stacked a tab is displayed at the bottom of
the windows. Clicking on a tab selects that window.
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To separate the stacked windows double-click or drag the tab of the window you want to separate.
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Auto hiding windows
All docking windows support auto hiding by using the pin on the title bar. When the pin is released by clicking
on it the window is minimized to a tab on the left or right margin. When the cursor is put over the tab the window
opens. When the cursor is put somewhere else on the display the window auto hides.

To set auto hide

To make a window auto hide click the push pin icon  in the title bar of the window. The window is minimized
to a tab.

The tab displays the windows name. To open the window place the cursor on the tab. The window opens from
the tab and can then be accessed.
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When the cursor focus is removed from the window it will auto hide.

To turn off auto hide for a window

Clicking the push pin icon  in the title bar of an open auto hide window will then pin the window to the
display and turn off auto hide.

16  Using the mouse and keyboad in the layaout pane
You can edit each object of text, image, barcode, table and line by using the mouse and keyboard in the layout
pane. You can select, cut, copy, paste, move, delete, resize objects, edit text in the object and insert new objects.
The set values and changes are all reflected in the property settings of each object.
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16.1  General

Making an object area
To make an object area select the type of object you want to make either from the Object menu or the tool bar.
Then drag the cursor to create a rectangle on the layout pane where you want the object positioned.

Selecting an object
To select an object click the inside the rectangular area of the object. Square marks are displayed on the four
corners of the selected object.

The object has not been selected.

The object has been selected.

Selecting multiple objects

Multiple objects are selected by clicking on objects while holding the [Shift] key down.

Multiple objects can be selected in the layout pane by drawing a rectangle with the mouse completely around the
objects to be selected. If an object is not completely enclosed by the rectangle it will not be selected.
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Priority object
When multiple objects are selected the last object selected is the priority object. The priority object is used as the
standard for "Autofit" and selected properties such as the font setting. If you want to give priority to a specific
object that has already been selected, release the object and reselect it last. To release only one selected object
while selecting multiple objects, click on the object while holding the [Ctrl] key.

Cutting an object
Select the object and choose Cut or Clear from the Edit menu. Or, choose Cut from the context menu which is
shown by clicking the right mouse button.

Copy an object
Select the object and choose Copy from the Edit menu or the context menu which is shown by clicking the right
mouse button.

Paste an object
Once an object has been cut or copied it is placed on the clipboad. By choosing Paste from the Edit menu or the
context menu you can then paste from the clipboard onto the layout pane.

Moving an object
The object is moved by clicking inside the object area and dragging it.
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Moving multiple objects
Select the multiple objects and then click inside the selected area and drag the objects,

Clearing an object
Select the object and choose Clear from the Edit menu.

Change Size of an object
Select the object and then drag any of the corners to scale (change both the width and height of the object) or drag
on any edge to change either the width or height of the object.

When the edge is dragged the object size is only changed in one direction, width or height.
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Cancel while moving or changing size
To cancel moving an object or changing the size while dragging hit the [ESC] key. This will return the object to
its original positon and will restore the object to its original size.

Edit a text object
Double-clicking on a text object selects the object and shifts to the edit mode. Edit mode only applies to text
objects.

16.2  Tables

Selecting each part of a table

Table To select part of a table click on the part with the mouse. Do not click on the lines.

Table-
body,
table-
header,
table-
footer

The body, header and footer of a table have to be selected using the object tree in the Objects tree
window.

column By clicking the top edge of a table column you can select the entire column. If the table has a caption
on top you have to click at the top of the column under the caption in order to select the column.

To select multiple columns click the top edge of the columns while holding the [Shift] key.
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row and
caption

By clicking the left edge of the table you can select the caption or a row of the table. By holding the
[Shift] key down you can select multiple rows and the caption.

cell To select a cell first select the table and then click on the cell. Once the cell is selected it will turn
grey.

To unselect a cell click either outside the limits of the table or the cell.

Selecting multiple cells

Select the first cell (beginning cell) and then while holding the [Shift] key select the next cell (end
cell). All cells within the rectangle from the beginning cell to the end cell will be selected.

Additional or individual cells can also be added by selecting another cell while holding the [Ctrl] key
when you click on the the new cell.

Changing the size of table objects

table The size of the table is changed by selecting the table and then dragging on any of the four corners of
the table. When the size of table is changed the column widths and row heights are scaled relative to
the size change.
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The size of the table has to be changed from the corners and not just the outside edge lines.

table-
body,
table-
header,
table-
footer

The size of Objects within the table-body, header and footer depends on the size settings for the object.
Unless the setting, such as with an image, is set to fit the size of the cell the size of the individual
objects are not changed by changing the size of the table.

column The width of a column is changed by dragging the line between the rows.
When the width of a column is changed the width of the column to the right is also changed. Changing
column widths does not change the size of the table except when the width of the last column is changed
by dragging on the line on the right side of the last column.
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You can change the width of an individual column and the overall width of the table by dragging on
the line between the rows while holding the [Shift] key. The width of the column to the right does not
change and only the width of the column selected is changed.

row The height of a row can be changed by dragging on the botton line of the row.
Other rows are not effected but the size of the table is changed.

If the [Shift] key is held while dragging the line between two rows, then the heights of the two rows
changes. The size of the table does not change.
To change the height of the caption above the table drag the top line of the table.
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To change the height of the caption below the table drag the bottom line of the table.

Selecting and editing objects in cells
By double-clicking a cell the object in the cell is selected and placed in the edit mode for text objects and the
selection mode for image and barcode objects.

Cut and insert a Column
Select the column to be cut and then choose Cut in the Table / Column menu or Cut context menu which is shown
by clicking the right mouse button.



114

You can add new columns to the left or right of a column by first selecting the column and then selecting from
the Table / Column menu Insert left or insert right.
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Autofit Column Width
Multiple columns can be set to the same width by selecting multiple columns and then selecting in the Table /
Column menu or the context menu Autofit. The selected columns will be evenly resized within the width space
occupied by the columns.

Cut and insert of Row
Select the target row in the table and choose Table / Row Cut from the menu or Cut in the context menu which
is shown by clicking the right mouse button.
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You can add a new row above or below a selected row by selecting the row and then choosing from the Table /
Row menu Insert Above or Insert Below.
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Autofit Row heights
Multiple rows can be set to the same height by selecting multiple rows and then selecting in the Table / Row menu
or the context menu Autofit. The selected rows will be evenly resized within the height space occupied by the
rows.
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Cut and insert a Caption
To cut a caption select the caption and then in the Table / Caption menu choose Cut. This can also be done through
the context menu which is shown by clicking the right mouse button.
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To insert a caption select the table and then in the Table / Caption menu choose Insert Above or Insert Below.
This can also be done through the context menu which is shown by clicking the right mouse button.
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Cut and insert a Header/Footer
To cut a Header or Footer select the target table and then in the Table menu choose either Header / cut or Footer /
cut. This can also be done through the context menu which is shown by clicking the right mouse button.

You can add new Header/Footer to the table by using the Insert Header or Footer in the Table menu.
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Changing the object type for a column
By default the object type in a cell is text. By columns the Object type can be changed to either an image or barcode
object.

1. Changing the properties of a column

Select the target column in the layout pane, or "column-info" in the Objects tree window.

With the column (or "column-info") chosen open the Properties window and specify the object type of
Column type.
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2. Using the "Table setup" dialogue

Select the table and open the Table setup dialogue from Table / Setting menu. Open Column setting tab
and specify Type of object for the column.



 Project and object settings
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This chapter explains the Project setup and object settings that control the formatting of a report.

17  Project setting
The report layout that XSL Report Designer creates is called the "Project." The various pieces that XSL Report
Designer uses to construct a project are call "Objects." All the informatin about the project design and layout and
the objects are stored in a project file.

17.1  Project settings

The following settings (Project setup) are necessary for XSL Report Designer when making a project:

■ Layout type

■ An XML data file to be referred to for structure, path and repeat information.

When making a project XSL Report Designer uses the XML data file as a reference to map the elements to the
objects and how they should be formatted. For TSV/CSV data XSL Report Designer automatically creates an
XML data file. The setting for XML data and TSV/CSV data are:

Reference data
file

XML file that refers to structure Layout
type

Repeat XML
path

XML data file The XML file that refers to structure is set through the New
project guide 3/3 or the Project setup dialogue of the Project
menu

Fixed
type,
Flow type
or Label
type

Specify the
XML path in the
XML file that
refers to the
structure

TSV/CSV data
file

The name XSL Report Designer gives to the XML data that
it automatically generates from the TSV/CSV file is placed
on the New project guide 3/3

Flow type
only

Set
automatically
according to the
setting of the
Data items in the
TSV/CSV file
(table/list)

17.2  Layout type

The layout pattern for printing the report is called the "Layout type." When the original data file is XML the layout
type can be:

1. Fixed type
2. Flow type
3. Label type

Once the layout type has been selected for a project it cannot be changed. It is possible to copy and move
objects with their settings from one project to another project.

For TSV/CSV files the layout type is always "Flow type."
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17.3  Reference data file and XML path

When you start a new project you have to specify either an XML or a TSV/CSV data file through the New project
guide.

1. XML data file
2. TSV/CSV data file

 Note;
XSL Report Designer must convert the TSV/CSV file to XML in order to use the data for the design process
and also for the Runtime Engine to transform the data to XSL-FO for print and PDF output. The TSV/CSV
conversion is built into XSL Report Designer and is an automatic process.

Referenced XML data file

■ XML file that is referrd to for structure

You can specify in the New project guide 3/3 or the Project setup dialogue of the Project menu the XML
file that XSL Report Designer refers to when working on a project.

 Note;

■ XSL Report Designer creates a layout design for printing predefined forms and reports containing XML
data. The XML data for printing is assumed to have a constant repetition pattern in the tree structure. It
is not possible with XSL Report Designer to design a layout for documents such as general books and
technical manuals because they do not have a constant repetition pattern of the tree structure of their XML
data.

■ XML files with namespaces have to declare all namespaces in the root element.

■ Default Namespaces are not supported by the Runtime Engine or XSLT processors. Thus Default
Namespace declaration in a file must be deleted before trying to process with XSLT and the Runtime
Engine. This is a limitation of XPath.

■ Repeat XML path in the project

Repeat XML path in the New project guide 3/3 or the Project setup dialogue of Project menu specifies the
XML path to the element in data to be processed as the main repeat when formatting data for print or PDF.
Each repetition of the main repeat in data creates a new report in output.

The two methods of setting the XML path to the main repeat, besides the New project guide 3/3, are:

1. Through the Project setup dialogue in the Project menu.
2. By choosing the highest repeat object in the Objects tree window and setting it to the XML path in

the Property window.

TSV/CSV data file

■ XML file that refers to structure of TSV/CSV data

When the project refers to a TSV/CSV file XSL Report Designer automatically generates an XML file that
is specified in the New project guide 3/3.
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  Example of XML file generated from TSV/CSV file automatically
CSV data file

year 2002,1st Quarter,2nd Quarter,3rd Quarter,4th Quarter,Total,Average
Product_A,"1,000","1,050","1,100","1,150","4,300","1,075"
Product_B,"1,100","1,150","1,200","1,250","4,700","1,175"
Product_C,"1,200","1,250","1,300","1,350","5,100","1,275"
Product_D,"1,300","1,350","1,400","1,450","5,500","1,375"
quarterly average,,,,,,"1,225"
XML file automatically generated by XSL Report Designer

<?xml version="1.0"?>
<sample>
    <record>
        <member1>year 2002</member1>
        <member2>1st Quarter</member2>
        <member3>2nd Quarter</member3>
        <member4>3rd Quarter</member4>
        <member5>4th Quarter</member5>
        <member6>Total</member6>
        <member7>Average</member7>
    </record>
    <record>
        <member1>Product_A</member1>
        <member2>1,000</member2>
        <member3>1,050</member3>
        <member4>1,100</member4>
        <member5>1,150</member5>
        <member6>4,300</member6>
        <member7>1,075</member7>
    </record>
    <record>
        <member1>Product_B</member1>
    .
    .
    .
    </record>
</sample>
The same XML file is generated from the TSV/CSV file regardless of whether it is going to be a table or list in
XSL Report Designer.

■ Repeat XML path

When a new project is created that refers to a TSV/CSV file how to treat the data items is specified by the
Data items in the New project guide 2/3.
The options are:

to be Table
This option inputs the TSV/CSV data as a table in the project.
to be List
This option inputs the TSV/CSV data as a list in the project.

The layout is designed and the XML path is set automatically in the project according to the specified
content of the TSV/CSV input.
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The path setting for the XML elements to the objects for a Table and List are as follows:

Generated element Description Reflection in data item

to be Table to be List

<sample> Becomes the root of XML file Set to the Repeat XML path
of the project (main repeat)

not used

<record> One line of TSV/CSV data is
considered to be one record.
This element is repeated by the
number of records

Set as the Repeat XML path
in the table object

Set to the Repeat XML path
of the project (main repeat)

<memberN> Each element in the record (N
is made by the number of
elements from 1)

Arranged as a text object in
the table object with the
XML path set to each
element

Arranged as a text object
with the XML path set to
each element

  Examples of a Table and a List along with their layout pane from the project file produced from TSV/
CSV data.
Once you have completed the New project guide for a TSV/CSV file the layout pane is opened and a project
file according to specification is displayed. The first screen of each layout pane is as follows.

■ When "to be Table" is specified

In this project file, "sample," the root element is set as the main repeat. The table object is placed as the child
of the main repeat and the static text of "memberN" is automatically added to table-header. The table can now
be freely modified.
The following is the preview display using XSL Formatter or AH Formatter.

■ When "to be List" is specified
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In this project "sample/record" is set as main repeat. The text objects are arranged in list form and a static text
of "memberN" is added automatically.
The following is the preview display using XSL Formatter or AH Formatter.
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18  Object and Property
The items of a report to be arranged in the layout of XSL Report Designer are called "Objects." "Property"
(attributes) can be set for each object. 

18.1  List of object

XSL Report Designer uses objects to set the frame of report (composition object) and as objects that are arranged
on the form (layout object).

When used Object name Description Operation

composition
object

Root document The root of the
project file. All
projects always
have one
document object.

Example （page 130 )

Header/Footer
for report or
page

report header/
footer, page header/
footer

When specified
the Report header
creates either a
page at the front
of the project and
the report footer
creates a page at
the end of the
project or a
header at the very
beginning of the
project and footer
at the very end of
the project. These
are only output
once for the entire
report. Page
header/footer is
output on each
page.

Example (report-header/
footer) （page 133 )

The object to be
repeated

repeat All projects have
a main repeat
object specified
by the Repeat
XML path. Flow
type layouts can
have multiple sub
repeats that can
arranged as the
children of the
main repeat.

Example （page 137 )

Grouping of
object for
layout

page object, frame
object, label object

Only one type can
be used with each
project.

Example (page) （page 140 )

layout object The building
blocks of a
layout, these

text object, image
object, barcode
object, table object,

Used to arranges
the content for
formatting.

Example （page 173 )
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are arranged on
the layout pane.

caption, column-
info, table-header/
footer, table-body,
table-row, table-
cell, line object

Specifies the
position and style
for each piece of
content in the
layout.

Relation of composition objects in the project
The relationship between composition objects in the project depends on the layout type as illustrated below.

Fixed type/Label type Flow type

The page object is used for Fixed type layouts and the
label object is used for Label type layouts.

The frame object is used for Flow type layouts.

18.2  Document object

The document object is the root object of the project file. The acutal document object is not displayed on the
layout pane. The "document" object has to be selected on the Objects tree window. 
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Properties for Document object

■ General Properties

Properties Value Description

Object type document The root object of the project.

Layout type Fixed/Flow/Label The project layout type. Cannot be changed.

Paper type arbitrary The paper type/size selected for the project. Cannot be changed here.

Comment arbitrary Character string that can be freely edited. Has no effect on formatting
or the project.

■ Structure Property

Properties Value Description

Reference XML file Path of reference XML file The XML file that has been set as a reference for the
structure. Cannot be changed here.

19  Composition objects and properties by layout type
This section explains composition object and properties by each layout type.

19.1  Fixed type

In the Fixed type layout print data is arranged on the page (page object) in fixed locations. The position and size
of objects are fixed except for the table object which can be set in the properties to automatically expands based
on the data. This might cause the table to overlap the object below it. When formatting each repeat of data creates
a new form.
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Output example of Fixed type

Page header/footer can be specified. Report header/footer can be specified. One record of data can compose
multiple pages such as in an order form where the first page is the order and the second page is the terms and
conditions.

The screen display for Fixed type
The first screen for the Fixed type project shows the following:

In the Objects tree window you can see that the repeat object has been put under the document object and a page
object has been put under the repeat object.
In the layout pane the paper with the page margins is displayed. Inside the margins is the body area. The body
area is the page object.
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Report-header/report-footer object for Fixed type
For a Fixed type layout Report header is a page at the front of a project and Report footer is a page at the end of
the project. When the report header or report footer in the Header/Footer dialogue in the Structure menu is selected
a report-header object or report-footer object is put on the layout pane with the header at the very top of the layout
pane and the footer at the very bottom. When the report-header or report-footer is selected in the Objects tree
window a green line is displayed on the layout pane below the header or footer. 

For Fixed type layout the report header/report footer is always output to only one page of the report and uses the
same paper as the body. The report-header/report-footer object corresponds to a rectangular area that has the
height specified by the Height property from the top margin of the paper.
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Properties for report-header/report-footer object:
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■ General Properties

Properties Value Description

Object type report-header/report-footer Page preceeding / page following the actual reports of a data
set.

Height Numeric value (mm/in/pt) Displays the height of the area the Report header or footer will
print on. To change the height drag the green line under report
header/report footer up or down in the layout pane. It is also
possible to edit the numerical value in the Properties window.

■ Arrange Property

Properties Value Description

Page break Yes For a Fixed type layout the Report Header and Report Footer are always output to
new pages or at the very beginning and end of the report.

■ Border Properties

Properties Value Description

Border style for
Top / Bottom /
Left / Right

None/Dotted/Dashed/Solid/Double/
Groove/Ridge/Inset/Outset

Used to individually
set the styles for the
top, bottom, left and
right borders.

Diagonal style Used to set the
styles for the
Diagonal and
Reverse diagonal.

Border width for
Top / Bottom /
Left / Right

Numeric value
mm (millimeters)
in (inches)
pt (points)

Used to individually
set the widths for the
top, bottom, left and
right borders.

Diagonal width Used to set the
widths for the
Diagonal and
Reverse diagonal.

Border color for
Top / Bottom /
Left / Right

Hexadecimal RGB value starting with #, or W3C color name. The color for each
border is
individually set.

Diagonal color Diagonal and
Reverse diagonal
color.

■ Print Properties

Properties Value Description

Print page header Yes/No When report header and report footer is set to print used to set whether to
also print page header.

Print page footer Yes/No When report header and report footer is set to print used to set whether to
also print page footer.

http://www.w3.org/TR/SVG11/types.html#ColorKeywords
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Print control Print/Not Controls printing of the input object. "Print" prints according to the setting.
"Not" doesn't print regardless of the setting.

■ Page number Property

Properties Value Description

Include page count Yes/No Sets whether to include report header/report footer in the page count.

Page-header/page-footer object for Fixed type
A page-header object or page-footer object is placed on the layout pane when you specify page header or page
footer in the Header/Footer dialogue in the Structure menu. The page header and page footer are displayed directly
above and below the page body. Report header and footer display outside the page header and footer. When page-
header or page-footer is selected in the Objects tree window a green line is displayed on the layout pane below
the header or footer.

Page-header object corresponds to a rectangular area that has the height specified by the Height property from
the top margin of the paper. Page-footer object corresponds to a rectangular area that has the height specified by
the Height property from the bottom margin of the paper.
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Properties for page-header/page-footer object:

■ General Properties

Properties Value Description

Object type page-header/page-footer The type of the object is page-header/page-footer.

Height Numeric value
mm (millimeters)
in (inches)
pt (points)

Displays the height of the page header or page footer. To change
the height drag the green line under page header/page footer up
or down in the layout pane. It is also possible to edit the numerical
value in the Properties window.

■ Print Property

Properties Value Description

Print control Print/Not Controls printing of the input object. "Print" prints according to the setting.
"Not" doesn't print regardless of the setting.

Repeat object for Fixed type
A Fixed type project has one repeat object, the main repeat.
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Example of setting of repeat

Using the sample file, "Sample-data.xml," (provided with XSL Report Designer) the relationship of the main
repeat to the repetition of the elements of XML data specified by Repeat XML path can be seen.
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In the sample XML file ten "order-info" elements exist as children of the "order-management" element. Moreover,
"order-info" has eight "order/order-list" elements as the descendant element.

In the project file the "orderinfo" element is specified as the "Repeat XML path." Whenever "orderinfo" appears
in data the main repeat object is generated and a new report is produced. For this example the main repeat produces
one page; orderinfo is repeated in the data 10 times, thus producing 10 pages. Because a Fixed type project can
only have one repeat, the repetitions in the "order-list" element are in a subordinate position to the table in this
example.

The Repeat object is not displayed on the layout pane and must be selected from the Objects tree window in order
to display properties in the Property window.

Properties for repeat object:

■ General Property

Properties Value Description

Object type repeat The repeat object.

■ Structure Property

Properties Value Description

Repeat path Path of the first main repeat
element within the XML data

Specifies which part of the XML
data is to be formatted.
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■ Arrange Property

Properties Value Description

Page break Yes Specifies whether or not to put a page break at the end of the
repeat. For Fixed type the page break is always set to yes.

■ Page number Properties

Properties Value Description

Reset page number Yes/No Specifies whether to initialize the page number for
each repeat object in the set.

First page number arbitrary Used to set the first page.

Page object
The page object is contained within the main repeat of the Fixed type. When designing a layout each layout object
is arranged on the page object. The XY coordinates for objects on the layout is measured from the left and top
margins of the page body. Layout objects can also be set in the page margins; however the coordinate value for
the object will still be based on the left and top margins of the page body. A page can be added by Insert frame
(page) function.

Multiple page objects can be inserted by Insert frame (page) in the Structure menu.
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Properties for page object:

■ General Property

Properties Value Description

Object type page The page object.

■ Border Properties

Refer to Border Properties（page 135 )

19.2  Flow type

Flow type layouts use frames (frame object) to enclose a group of layout objects. The frame objects are then
arranged sequentially to print. In Flow type the layout object can expand or contract freely by the size of the
content data. In addition, the frame object containing a group can expand or contract along with the expansion
and contraction of the internal layout objects. The position of following objects changes due to the expansion and
contraction of the object. For instance when a table object expands or contracts according to the number of lines
of data the positions of the objects following the table also changes. The Flow type layout derives its name from
the objects floating or flowing into the layout. There is no concept of repeating for each page; instead the number
of pages in the printed layout for each report will depend on the size of the repeating data.
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Output example of Flow type

Page header/footer can be specified. Report header/footer can be specified. The layout is composed of multiple
frames as opposed to pages.

The screen display for Flow type
Once a Flow type project has been selected in the New Project Guide the first screen for the Flow type will be as
follows:

In the Objects tree window you will see that repeat object put under the document object and a frame object put
under that.
In the layout pane one frame will be displayed with right and left margin.
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Report-header/report-footer object for Flow type
Refer to Report-header/report-footer object for Fixed type（page 133 )

When you specify report header or report footer in Flow type they are displayed in the layout pane with the header
at the top of the frames and the footer at the bottom of the frames. When printed the header will be at the beginning
of the report and the footer will be at the end of the report. The report header and report footer can be printed on
the same page as the body of the report or they can be printed on separate pages.



144

Properties for report-header/report-footer object:
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■ General Properties

Refer to General Properties（page 135 )

■ Arrange Property

Properties Value Description

Page break Yes/No Specifies whether to break the page at the end of the object for report header.

■ Border Properties

Refer to Border Properties（page 135 )

■ Print Properties

Refer to Print Properties（page 135 )

■ Page number Property

Refer to Page number Property（page 136 )

Page-header/page-footer object for Flow type
Refer to Page-header/page-footer object for Fixed type（page 136 )

When page header or page footer is specified for Flow type, they are displayed on the layout pane above and
below the frame but before a report header or report footer. The features of the page header/page footer are the
same as for the Fixed type layout.
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Properties for page-header/page-footer object:

■ General Properties

Refer to General Properties（page 137 )

■ Print Property

Refer to Print Property（page 137 )

Repeat object for Flow type
Refer to Repeat object for Fixed type（page 137 )

Flow type project automatically has one repeat object, the main repeat.
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In Flow type multiple repeat objects can be inserted using the Insert repeat of the Structure menu. The inserted
repeat object becomes a sub repeat. In Flow type the layout can be designed to handle XML data that has repeating
elements nested within repeating elements, nested repetitions.

The following example illustrates handling XML data with nested repetitions.

<root>
 <main>
  <p>main (1)</
p>
  <sub-1>
   <p>sub-1 (1)</
p>
   <sub-2>
    <p>Sub-2 
(1)</p>
   </sub-2>
   <sub-2>
    <p>Sub-2 
(2)</p>
   </sub-2>
   <sub-2>
    <p>Sub-2 
(3)</p>
   </sub-2>
  </sub-1>
  <sub-1>
   <p>sub-1 (2)</
p>
   <sub-2>
    <p>Sub-2 

 <main>
  <p>main 
(2)</p>
  <sub-1>
   <p>sub-1 
(1)</p>
   <sub-2>
    <p>Sub-2 
(1)</p>
   </sub-2>
   <sub-2>
    <p>Sub-2 
(2)</p>
   </sub-2>
  </sub-1>
  <sub-1>
   <p>sub-1 
(2)</p>
   <sub-2>
    <p>Sub-2 
(1)</p>
   </sub-2>
  </sub-1>

 <main>
  <p>main (3)</p>
  <sub-1>
   <p>sub-1 (1)</
p>
   <sub-2>
    <p>Sub-2 (1)</
p>
   </sub-2>
  </sub-1>
  <sub-1>
   <p>sub-1 (2)</
p>
   <sub-2>
    <p>Sub-2 (1)</
p>
   </sub-2>
  </sub-1>
  <sub-1>
   <p>sub-1 (3)</
p>
   <sub-2>
    <p>Sub-2 (1)</
p>

Tree structure of XML
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(1)</p>
   </sub-2>
  </sub-1>
  <sub-1>
   <p>sub-1 (3)</
p>
   <sub-2>
    <p>Sub-2 
(1)</p>
   </sub-2>
  </sub-1>
 </main>
 

 </main>
 

   </sub-2>
  </sub-1>
  <sub-1>
   <p>sub-1 (4)</
p>
   <sub-2>
    <p>Sub-2 (1)</
p>
   </sub-2>
   <sub-2>
    <p>Sub-2 (2)</
p>
   </sub-2>
  </sub-1>
 </main>
 </root>

XSL Report Designer is able to design a layout to support the nested repetition by arranging the repetitions in
hierarchical order as follows:.

In this project the XML data previously shown would print as follows: You can see that the "main" element is
repeated as main repeat. Inside of that is the repetition of "sub-1" element repeated several times and inside of
sub-1 is the repetition of "sub-2" element.
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The Repeat object is not displayed on the layout pane. Select "repeat" on the Objects tree window to display
property in the Properties window.

Properties for repeat object:

■ General Property

Refer to General Property（page 139 )

■ Structure Property

Refer to Structure Property（page 139 )

■ Arrange Property

Refer to Arrange Property（page 140 )

■ Page number Properties

Refer to Page number Properties（page 140 )

Frame object
When frame object is selected in the Objects tree window a light blue line is displayed on the layout pane. Above
the line is the frame object. The frame object corresponds to one frame area. Layout objects are arranged in this
frame. Multiple frames can be sequentially added and additional objects can be grouped within the frames.
However, frame objects cannot be put side by side.
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Multiple frame objects can be inserted by Insert frame (page) of the Structure menu.

Properties for frame object:
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■ General Properties

Properties Value Description

Object type frame Object type is frame object.

Height Numeric value
mm (millimeters)
in (inches)
pt (points)

It specifies the height of the frame. When the arrange property of the
frame is set to "Fixed" the height of the frame is set at a fixed height.
When set to "Flow," the height of frame will depend on the content of
the layout objects. To change the height of a frame drag the light blue
line under frame up and down. It is also possible to input an arbitrary
numerical value for the Height in the Properties window. Please note
that a new page of output will be automatically created when the
combined height of the frame and the header is larger than the height of
the body area (area inside the margins) on the page.

■ Structure Property

Properties Value Description

Parent repeat path Path to the element of XML data to be
printed

The repeat path set to the parent repeat is
displayed. When the value is changed, it is
reflected in the property of the repeat.

■ Arrange Properties

Properties Value Description

Place Fixed/Flow Used to set the arrangement of the frame objects. "Fixed" sets the height of
the frame object by an absolute value from the top of the frame. The height
of the frame does not change even if the length of the object expands beyond
the specified height. When "Flow" is set, as the height of the object expands,
the height of other objects and frames expands accordingly to accommodate
the expanded object. If objects are placed horizontally in a frame it is not
possible to apply Flow to the frame.

Keep together Yes/No Specifies whether to arrange objects in frame on the same page.

Page break Yes/No Specifies whether to break page at the end of the frame object.

Example of frame object arrangement

The following are examples of "Fixed" and "Flow" that can be set by the arrangement property of the frame
object.
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■ Border Properties

Refer to Border Properties（page 135 )

19.3  Label type

In Label type the specified page is divided into user defined units called labels (label object) for formatting. The
same output pattern is repeated label by label by starting each new label at the main repeat element.

The page length and width are divided into the specified number of units (number of labels widthwise and
lengthwise) on the New project guide 2/3.
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Output example of Label type

The Label type looks very similar to the Fixed type. A big difference is that Label type can divide the page
vertically and horizontally into units and the object is arranged within one unit. It is used when multiple records
are sequentially printed on one page.

The label object can be a fixed size and arranged at a fixed position. In Label type if the Report header/footer is
specified it is always printed on a separate page. The label layout cannot be composed of multiple pages.

The first window for Label type
When Label type is specified one label is displayed in the layout pane. The objects are arranged in this area.

You will see repeat object is put under the document object and one label object is put under that in the Objects
tree window..
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Report-header/report-footer object for Label type
Refer to Report-header/report-footer object for Fixed type （page 133 )

When you specify report header or report footer in Label type, they are displayed above and below the label object
in the layout pane.
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Properties for report-header/report-footer object:
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■ General Properties

Refer to General Properties（page 135 )

■ Arrange Property

Refer to Arrange Property（page 135 )

■ Border Properties

Refer to Border Properties（page 135 )

■ Print Properties

Refer to Print Properties（page 135 )

■ Page number Property

Refer to Page number Property（page 136 )

Page-header/page-footer object for Label type
Refer to Page-header/page-footer object for Fixed type（page 136 )

When page header or page footer is specified for Label type, it is displayed on the layout pane as follows:
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Properties for page-header/page-footer object:

■ General Properties

Refer to General Properties （page 137 )

■ Print Property

Refer to Print Property（page 137 )

Repeat object for Label type
Refer to Repeat object for Fixed type （page 137 )

Label type has one repeat, the main repeat. Whenever the main repeat element set in the XML path appears one
label object is output.
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The Repeat object is not displayed on the layout pane and has to be selected on the Objects tree window to display
property in the Properties window.

Properties for repeat object:

■ General Property

Refer to General Property（page 139 )

■ Structure Property

Refer to Structure Property（page 139 )

■ Arrange Property

Refer to Arrange Property（page 140 )

■ Page number Properties

Refer to Page number Properties（page 140 )

label object
Label object is only used when Label type is selected as the layout type. The paper is divided vertically and
horizontally into label objects when the project is set and only one label object is displayed in the layout pane as
the body area.
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Properties for label object:

■ General Property

Properties Value Description

Object type label Object type is label.

■ Border Properties

Refer to Border Properties（page 135 )
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 Objects for layout
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This chapter explains how in a project to input and set each property of the layout objects. The objects are arranged
in the page, frame and label. Refer to Properties list（page 206 ) for the detailed property information for each
object. 

20  Object and content for page, frame and label objects
After completing the initial project settings using the the New Project Guide and the reference file Report Designer
is now ready to design the report by arranging the layout objects. The report is designed by using the following
steps on the layout pane:

1. Arrange the layout object.
2. Set property for the object.
3. Input contents into the object.

By repeating the above steps till all objects are layed out you can make the report. The order of setting the property
for the object and inputting the content can be reversed.

20.1  Objects that can be arranged

The following Objects can be arranged in page, frame and label objects.

Object name Object type Description Operation

Text text The text object is used when arranging text and numeric
values. The text or numeric content can be either directly
input into the object or acquired from the XML data.

Example（page 173 )

Image image The image object is used when arranging an image. The
image content can be either directly input into the object or
acquired from the XML data.

Example（page 183 )

Barcode barcode The barcode object is used for arranging barcodes. The
barcode content can be either directly input into the object
or acquired from the XML data.

Example（page 187 )

Table table The table object is used when a table is used to arrange text,
image and barcode objects.

Example（page 190 )

Line line The line object is used when placing a single horizontal or
vertical line on the layout. The line can be solid, hatched,
etc.

Example（page 202 )

■ In the Properties window under General the Object type is displayed.

■ Table objects contain caption, column-info, table-header, table-footer, table-body, table-rows and table-
cells.

20.2  Property settings

Property settings are made by selecting the target object on the layout pane to display the associated properties
in the Properties window or the Property menu.
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The Properties that can be set for each object are different. For the different properties refer to the following
explanations and the Properties list（page 206 ).

20.3  Inputting the content

The input content of each object is arranged according to the usage. The following two methods can be used to
input content to text, image and barcode objects:

■ Direct Input with XSL Report Designer
The content is input directly into the object on the layout pane. By double clicking on a text object you can
then type directly into the object.

■ Acquire and embed the content from XML data
By setting the path to an element in the XML data to be printed (this is called "XML path") and then
embedding the XML data. (Refer to the next section.)
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21  Property settings for acquiring content from XML data

21.1  Properties that refer to XML data

When content is acquired from XML data and placed in an object, which element of the XML data is acquired is
decided by setting the following properties: 

Properties Value Description

Kind Static Static content is input directly on the layout pane and is not acquired from XML data.
It can be a text string, a numeric value, an image or a barcode.

Field The content is acquired from XML data. The path to the element of XML data (XML
path) is set and the data specified by the XML path is embedded. The object type can
be text, numeric value, image, barcode and caption.

XML path XML path Specify which part of the XML data to embed as content. Becomes effective when
Property Kind is set to Field.

To acquire content from XML data select Property Kind Field and set XML path to the XML data to be input into
the report. When you click "XML path" in the Properties window, you will see the tree display of elements which
are descendent elements of the element set as "Repeat XML path" in the Project setup dialogue. Then, choose the
element that is to input in each object.
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21.2  Use of expression

Data can be further processed or formatted for output by applying an expression to the content acquired from the
XML data. 

Properties Value Description

Variable name arbitrary Sets a variable name for an object. The name can then
be referred to by expressions in the project.

Data type String/Number/Currency/Date Select the type of the text data according to the content
as either "String," "Number," "Currency" or "Date."

Expression Built-in Function list Set the expression when processing is necessary to
obtain the embedded data.

Format Conforms to Java.
Number, Currency, Date

Specify the format for "Number," "Currency" or "Date"
set in the data type property.

http://java.sun.com/j2se/1.5.0/docs/api/java/text/DecimalFormat.html
http://java.sun.com/j2se/1.5.0/docs/api/java/text/SimpleDateFormat.html
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Language Conforms to the language codes Set language information is used to decide format.

Country Conforms to the country codes Set country information is used to decide the format.

Property expression Built-in Function list Sets the property expression when dyanamic property
changes are needed.

By using the expression function you can easily set a complex expression, the date, the page number, automatic
formatting and so on. Refer to the Built-in Functions（page 220 ) for the available expressions.

Example of using expression

For these cells expressions have been used to set the method for displaying the numbers, for calculating the total
and for summing the columns.
For instance, "Variable name" and "Format" are specified for the property of the "Unit price" cell.

Also, the property of the "total" cell is displayed by using the "Variable names" specified for "unit price" and
"Quantity" by the expression.

http://lcweb.loc.gov/standards/iso639-2/iso639jac.html
http://www.iso.ch/iso/en/prods-services/iso3166ma/index.html
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In the following, "XPath" function is used.

Expression Input

By clicking on Expression in the Properties window the Expression dialogue window is opened for inputting the
expression. Once the Expression is input the Verification button can be used to check whether the expression is
correct.
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In an expression the variable name can only be set by opening the dialogue of the expression and clicking the
object of the variable name to be inserted.
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It is also possible to insert the XML path in the expression.

Format input guide

By clicking on Format in the Properties window the Input guide button for inputting the format is displayed.
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The dialogue of the Inupt guide depends on the Data type. The format cannot be specified when the Data type is
"String."

For "Number"

For "Currency"
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For "Date"

Format

The Format conforms to Java specifications. Please refer to the following for details.
Class DecimalFormat (for decimal numbers)、 Class SimpleDateFormat (for date)

Data type Format

Number / Currency 0 Digit

# Digit, zero shows as absent.

http://java.sun.com/j2se/1.5.0/docs/api/java/text/DecimalFormat.html
http://java.sun.com/j2se/1.5.0/docs/api/java/text/SimpleDateFormat.html
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. Decimal separator or monetary decimal separator

- Minus sign

, Grouping separator

E Separates mantissa and exponent in scientific notation. Need not be quoted in
prefix or suffix.

% Multiply by 100 and show as percentage.

u+2030 Multiply by 1000 and show as per mille.

u+00a4 Currency sign, replaced by currency symbol. If doubled, replaced by
international currency symbol. If present in a pattern, the monetary decimal
separator is used instead of the decimal separator.

Date G era designator

y year

M month in year

w week in year

W week in month

D day in year

d day in month

F day of week in month

E day in week

a am/pm marker

H hour in day (0~23)

k hour in day (1~24)

K hour in am/pm (0~11)

h hour in am/pm (1~12)

m minute in hour

s second in minute

S millisecond

z time zone

Z time zones in RFC822 format

Language Conforms to "Language codes" defined in ISO 639. Please refer to the following for details.
ISO 639/Joint Advisory Committee (ISO 639/JAC)

Country Conforms to "Country codes" defined in ISO 639. Please refer to the following for details.
ISO 3166 Maintenance agency (ISO 3166/MA) - ISO's focal point for country codes

http://lcweb.loc.gov/standards/iso639-2/iso639jac.html
http://www.iso.ch/iso/en/prods-services/iso3166ma/index.html


Objects for layout

173

22  Property settings for each object

22.1  Text object

New text objects can be placed on the layout pane by selecting New text from the Object menu and by making
an object frame with the mouse on the layout pane. 

The Kind of text object is displayed inside the top left corner of the object frame.  is for "Field" and  is
for "Static."

Properties Value Description

Object type text Type of object is text.

General Properties
Set the size, position and background color of the object.
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Properties Value Description

X Numeric value (mm/in/pt) Set X coordinates for the object. When a
margin is displayed the X coordinate is
measured from the from the left margin. If
no margin is displayed it is measured from
the left edge of the page, frame or label.

Y Numeric value (mm/in/pt) Set Y coordinates for the object. When a
margin is displayed the Y coordinate is
measured from the from the top margin. If
no margin is displayed it is measured from
the top edge of the page, frame or label.

Width Numeric value (mm/in/pt) Set the width of the object.

Height Numeric value (mm/in/pt) Set the height of the object.

Background color Hexadecimal RGB value starting with #, or
W3C color name.

Set the background color of the object area
defined by the rectangle.

The object's position and size can be controlled in the layout pane with the mouse. When the mouse is used the
values of X coordinates/Y coordinates/width/height of the object will automatically be reflected in the Properties
window. The numerical values can also be changed in the Properties window.

Color can be applied to the background of the text object area.

Example of setting size of object

Example of setting background color

http://www.w3.org/TR/SVG11/types.html#ColorKeywords
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Structure Properties
Used to specify the XML path for the reference XML data.

Properties Value Description

XML path Path to the element of the reference XML data Specifies which part of the XML data to embed.
Effective when Kind property is set to "Field."

Refer to Properties that refer to XML data（page 164 ) for a concrete input of XML path.

Type Properties
Set Type Properties of object; "Kind," "Value Name," "Data type," "Expressions," "Format," "Language" and
"Country."

Properties Value Description

Kind Field/Static Select the type of data in text object from "Field" or "Static."
When "Field" is selected the data specified by XML path is
embedded.

Variable name arbitrary Used to set a name to the object. The name set here can be
referred to by expressions in the project.

Data type String/Number/Currency/Date Select the type of the text data according to the content at
"String," "Number," "Currency" or "Date."

Expression Built-in function list The expression is set when its necessary to further process
the embedded data.

Format Uses Java conventions for
Number, Currency, Date

Specify the format for "Number," "Currency" or "Date" as
set in the data type property.

Language Conforms to the language codes Set language information used to control the formatting.

Country Conforms to the country codes Set country information used to control the formatting.

Refer to Use of expression（page 165 ) for further information about expressions.

Text Properties
Properties that control text and character formattering in the object. Also, controls line and paragraph formats.

Properties Value Description

White space treatment Ignore/
Preserve as white space/
Ignore if before linefeed/
Ignore if after linefeed/
Ignore if surrounding linefeed

"Ignore" ignores white
space. "Preserve as white
space" puts the space in at
the code position of the
white space. "Ignore if
before linefeed" ignores
the space before the
linefeed code. "Ignore if
after linefeed" ignores the
space after the linefeed
code. "Ignore if
surrounding linefeed"
ignores the blank before
and behind the linefeed
code.

http://java.sun.com/j2se/1.5.0/docs/api/java/text/DecimalFormat.html
http://java.sun.com/j2se/1.5.0/docs/api/java/text/SimpleDateFormat.html
http://lcweb.loc.gov/standards/iso639-2/iso639jac.html
http://www.iso.ch/iso/en/prods-services/iso3166ma/index.html


176

Linefeed treatment Ignore/
Preserve as linefeed/
Treat as space/
Treat as zero width space

"Ignore" ignores linefeed.
"Preserve as linefeed"
changes line at the linefeed
code position. "Treat as
space" treats the linefeed
code as a space. "Treat as
zero width space" treats
the linefeed code as a zero
width space.

Font family Select from the list The font family is set by
the font setting dialog.
Each value set by this
dialog is reflected in "Font
size," "Font style" and
"Font effect" property.

Font size Numeric value (pt) Font size is set.

Font style Select from the list Font style is set by the font
setting dialogue.

Font effect Select from the list Font effect is set by the
font setting dialogue.

Vertical script Yes/No Sets vertical writing
direction.

Text color Hexadecimal RGB value starging with #, or W3C color
name.

Sets text color.

Horizontal alignment Left/Right/Center/ Sets how the string is
arranged horizontally in
the rectangular area of the
object.

Bottom line alignment Left/Right/Center/ Sets the Horizontal
alignment of last line in the
object.

Vertical alignment Top/Middle/Bottom Sets how the string is
arranged vertically in the
rectangular area of the
object.

Letter spacing Numeric value (mm/in/pt) Sets letter spacing.

Line height Numeric value (mm/in/pt) Sets the line height.

Top line indent Numeric value (mm/in/pt) Sets the amount of indent
for the first line.

Overflow Hidden/Replace/Condense Sets how to handle
overflow when the text
exceeds the display area. Is
effective when the Auto
grow property is set to
"No." "Hidden" does not
print the overflowing data.
"Replace" prints the
character string set in
"Overflow replace." The
Overflow character string
is embedded repeatedly

http://www.w3.org/TR/SVG11/types.html#ColorKeywords
http://www.w3.org/TR/SVG11/types.html#ColorKeywords
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until the area is filled.
"Condense" condenses
according to the method
set in "Overflow
condense."

Overflow replace arbitrary Specifies the replacement
characters for "Replace" in
the Overflow property.

Overflow condense Condense font size/
Condense letter spacing/
Condense word spacing/
Condense font stretch/
Condense line height/
Auto

Sets the processing for
"condense" in "Overflow."
"Condense font size"
adjusts font size to
condense. "Condense
letter spacing" adjusts
character space to
condense. "Condense
word spacing" adjusts
word space to condense.
"Condense font stretch"
adjusts font stretch to
condense. "Condense line
height" adjusts line height
to condense. "Auto"
depends on the default of
the system.

The following are some examples.

Linefeed and space in the frame

Specifies how linefeed and white space in the frame are treated.
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Font effect

Font dialogue opens by selecting a text object in the layout pane and then clicking each property regarding font
in the Properties window. The font, size, color, style and effect are set here.

Clicking Text color opens the Color dialogue to set the color for the text.

To specify these properties for text in table cells select the "table-cell" object in the objects tree.

Text Aligment

Sets how the string is arranged horizontally in the rectangular area of the object.
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Height and alignment of the line

Sets the alignment of the line in the text area.

Letter Spaceing

Set the space between the characters.

Height and alignment of the line

Sets the height and alignment of the line in the text area.
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Indent for the first line

Sets the indent for the first line. The alignment of last line can also be set.

Overflow processing

Sets the method for processing the character overflow when the length of the inside character string is longer than
what the size of the object can hold.
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Arrange Properties

Properties Value Description

Auto grow Yes/No Sets whether to extend object according to size of
the data.

Top/Bottom/Left/Right
Padding

Numeric value (mm/in/pt) Sets the amount of the space between the top/
bottom/left/right edge of the rectangular area of
the object and the text.

Padding in the frame

Sets the amount of the space between top, bottom, left and right of a rectangular area of the object and the text.

Border Properties

Properties Value Description

Border (Top/Bottom/
Left/Right) style

None/Dotted/Dashed/Solid/Double/
Groove/Ridge/Inset/Outset

Sets the style of each
border line
individually.

Diagonal (Reverse
diagonal) style

Sets the style of
Diagonal (Reverse
diagonal).

Border (Top/Bottom/
Left/Right) width

Numeric value (mm/in/pt) Sets the width of each
border line
individually.

Diagonal (Reverse
diagonal) width

Sets the width of
Diagonal (Reverse
diagonal).

Border (Top/Bottom/
Left/Right) color

Hexadecimal RGB value starting with #, or W3C color name. Sets the color of each
border line
individually.

Diagonal (Reverse
diagonal) color

Sets the color of
Diagonal (Reverse
diagonal).

Frame border

The style, width and color of the border for the text object can be specified as can the border for the frame. Border
settings for text objects in table cells cannot be set. The border for the table cell can be set.

http://www.w3.org/TR/SVG11/types.html#ColorKeywords
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Put diagonal line in the cell

Inputs a Diagonal or Reverse diagonal line in the table cell. The style, width and color of the diagonal line can be
set.

The "Antenna House XSL Formatter V4.0" or later, or The "Antenna House AH Formatter V4.0" or later is
necessary for the screen display (preview), print and the PDF output of the diagonal and reverse diagonal.

Print Property

Properties Value Description

Print control Print/Value only/Not "Print" prints according to the setting. "Value only" prints only the value
and not the frame. This is used with pre-printed forms. "Not" does not print
regardless of the setting.

Print control

http://www.antennahouse.com/product/axfo40/axfo4top.htm
http://www.antennahouse.com/product/ahf50/ahf5top.htm
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Controls how the frame is printed. For instance you might want to have a frame with a memo or note such as the
following yellow frame. This can then be marked not to output to XSL-FO.

22.2  Image object

New image object can be put on layout pane by selecting New image from the Object menu and then making the
object frame with the mouse. 



184

The mark  in the upper left corner is used to denote an image object. Images cannot be edited in XSL Report
Designer.

Properties Value Description

Object type image The object type is image.

General Properties
The position where the object is placed and the size of the object can be controlled on the layout pane with the
mouse. Please refer to General Properties. （page 173 )

The background color property cannot be set for an image object.

Structure Properties
Specifies the XML path for the reference XML data. Please refer to Structure Properties. （page 175 )

Refer to Properties that refer to XML data（page 164 ) for additional information about the input of XML path.

Type Properties
Sets the object type.

Properties Value Description

Kind Field/Static Select the type of data in image object from "Field" or "Static." When "Field" is
selected the image specified by XML path is embedded.

Variable name arbitrary Used to set a name to the object. The name set here can be referred to by
expressions in the project.

Image Properties
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Properties Value Description

Image type BITMAP/JPEG/JPEG2000/
PNG/TIFF/GIF/SVG

Specifies what type image is selected; "BITMAP,"
"JPEG," "JPEG2000," "PNG," "TIFF," "GIF" and "SVG."

File path Path to the image file Path of the image file is set for "Static" in the Kind
property.

Save full path Yes/No Whether to save as full path. If "No" its saved as a relative
path.

Scaling Fit horizontal/
Fit vertical/
Fit to box/
Fit to image size/
dpi

Sets how the image expands and contracts to fit the image
rectangle. "Fit horizontal" holds the ratio of length and
breadth, then fits to the width of the frame. "Fit vertical"
holds the ratio of length and breadth, then fits to the length
of the frame. "Fit to box" does not hold the ratio of length
and breadth, then fits to the frame size. "Fit to image size"
sets the size specified by the image data. (Only for Vector
graphics) "dpi" matches dpi specified. (Only for Raster
graphics)

dpi Numeric value The dpi value for "dpi" in the Scaling property.

Clipping Clip/
No clip/
Fit to image

Whether to do clipping (maintain image size, but trim to
fit the frame). "Clip" keeps the image from overflowing
the frame. "No clip" overflows the frame. "Fit to image"
sets the frame size to fit the size of the image. Can only be
used for Vector graphics or when "dpi" is set in the Scaling
property.

Horizontal alignment left/right/center Sets the horizontal axis position "left," "right," "center" for
the frame.

Vertical alignment top/bottom/center Sets the vertical axis position to "top," "bottom," "center"
for the frame.

The following examples of image properties:

Image type

Specify the type of image.

Static image

When the Kind property is "Static" the path for the image file can be specified directly.
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When Save Full path is specified here the picture file is saved with the full path. Otherwise it is saved with the
relative path. The full path is convenient when the FO file is moved or is treated separately from the specified
image files.

Image frame

1. The size of image and frame

Sets how the image expands and contracts and is placed.

When "dpi" (dot per inch) is set as the input value the size of the image is controlled by the dpi value.
2. The position of the image in the frame

Used to set horizontal axis and vertical axis for positioning the image in the frame.
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Border Properties
A border can be placed around the frame of an object. Color, style and width can be specified. A diagonal and
reverse diagonal can also be placed on the frame and have have color, width and style specified. Please refer to
Border Properties. （page 181 )

Print Property
Please refer to Print Property. （page 182 )

22.3  Barcode object

In XSL Report Designer barcode objects can easily be prepared for print. The "XSL Formatter Barcode Option"
or The "AH Formatter Barcode Option" is required to use barcode object. "XSL Formatter Barcode Option" or
"AH Formatter Barcode Option" is available only for the Windows version of XSL Formatter or AH Formatter.

A new barcode object can be placed on the layout pane by selecting New barcode from the Object menu and then
making the object frame with the mouse.

http://antennahouse.com/product/barcode.htm
http://antennahouse.com/product/barcode.htm
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 is used to mark a barcode object.

Properties Value Description

Object type barcode The object type is barcode.

General Properties
The position where the object is placed and the size of the object can be controlled on the layout pane with the
mouse. Please refer to General Properties. （page 173 )

Structure Properties
Specifies the XML path for the XML data. Please refer to Structure Properties. （page 175 )

Refer to Properties that refer to XML data（page 164 ) for additional information on XML path.

Type Properties
Sets Type Properties such as the type of the object and the setting of the expression.

Properties Value Description

Kind Field/Static Select the type of data in the barcode object from "Field" or "Static."
When "Field" is selected the data specified by XML path is embedded.

Variable name arbitrary Sets a variable name for the object. The name set here can be referred to
by expressions in the project.

Expression Built-in function list Sets the expression when calculation or additional processing of the
embedded data is necessary.

Barcode Properties

Properties Value Description

Barcode value arbitrary Sets the data which is displayed as a barcode. It is effective
only when "Static" is set in "Kind."

Barcode type CODE39/CODE128/CODABAR/
EAN/EAN128/ITF/
JAN/POSTNET/UPC-A/UPC-E/
others

The type of the barcode is selected from "CODE39,"
"CODE128," "CODABAR," "EAN," "EAN128," "ITF,"
"JAN," "POSTNET," "UPC-A," "UPC-E" and "others."

String type font-code/code-value When "font-code" is selected the font code character string
is generated. When "code-value" is selected the code value
character string is generated. The code value character
string is a character string obtained by calculating the check
digit etc. In the preview display the barcodes that contain
numerical symbols might not display correctly. The display
will still show that the barcode is there. The font code
character string generates the correct barcode stripes
pattern as long as the font is correctly set.

Following is an example of working with Barcodes:

Barcode input

Barcode value property specifies the data that is to be displayed as a barcode. It is effective only when the Kind
property is set to "Static."
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The Barcode type is specified from among various barcode such as CODE39, JAN and so on.

String type property specifies what kind of string is generated as a barcode string from the data. "font-code" is
usually specified when you want to output the vertical stripes of the barcode by specifying the bar code font.
"code-value" is specified when the output that is generated contains automatically created start codes, etc. in the
character string. This helps when debugging the barcodes. If the vertical stripes of the barcode do not display
correctly, please check to make sure that the correct barcode font which has "font-code" as the property is specified.

The specifications for the following properties varies according to the type of the barcode. Please thoroughly
examine the specifications of the barcode you are using.
For instance, when "XSL Formatter Barcode Option" or "AH Formatter Barcode Option" is used with the EAN
code and the JAN code, the start code and the stop code are ignored even if they are specified according to the
specifications of the EAN code and the JAN code. Even if "No" is set to "Check digit" it is added according to
the specification of the EAN code and the JAN code.

Properties Description

Start code The start code for the barcode.

Stop code The stop code for the barcode. It is set according to the specification of barcode.

Check digit Specifies whether to put the check digit on the barcode.

The followings properties are automatically handled as long as the XSL Formatter barcode option or the AH
Formatter barcode option is used. These properties are provided for system developers to use when the the
processing of customized special barcodes is required. For more detailed information please send your inquiry to
support@antennahouse.com.

Properties Description

Barcode function's Java class name The complete barcode function's Java class name that processes the
barcode.

Aux This is the supplementary parameter used to generate the barcode. The
usage differs depending on the barcode used and the program (Java class
name of the bar code processing) that processes the barcode.

Text Properties
Properties that control text and character formattering in the object. Also, controls line and paragraph formats.

http://antennahouse.com/product/barcode.htm
http://antennahouse.com/product/barcode.htm
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Properties Value Description

Font family Select from the list The font family is set by the
font setting dialog. Each value
set by this dialog is reflected in
"Font size," "Font style" and
"Font effect" property.

Font size Numeric value (pt) Sets Font size.

Vertical script Yes/No Sets vertical writing direction.

Text color Hexadecimal RGB value starting with #, or W3C color
name.

Sets Text color.

Horizontal alignment None/Left/Right/Center/Justify Sets how the string is arranged
horizontally in the rectangular
area of the object.

Vertical alignment None/Top/Center/Bottom Sets how the string is arranged
vertically in the rectangular
area of the object.

Border Properties
Please refer to Border Properties. （page 181 )

Print Property
Please refer to Print Property. （page 182 )

22.4  Table object

New table object can be made by selecting New table from the Object menu and then making an object frame on
the layout pane with the mouse. Once the frame has been drawn the Table setup dialogue is displayed for setting
the table specifications. . 

http://www.w3.org/TR/SVG11/types.html#ColorKeywords
http://www.w3.org/TR/SVG11/types.html#ColorKeywords
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Once the specifications are set the table displaying the specified number of lines and columns is displayed. The
default object in the table cell is a text object.

Properties Value Description

Object type table The object type is table.

Objects in the table
Tables consists of multiple objects.

When the property of the parent object is set or is changed, the property of it's child object is changed to the same
value. When you want to change the property of the child object it has to be changed after setting property of
parent object.
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Object Objects tree display

table

caption

column-info
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table-body

table-row

table-cell
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text

When header and footer are specified the following objects are generated:

Object Objects tree display

table-header

table-footer

Please refer to text object, image object and barcode object for more detailed information about each object that
can be placed in a table cell.
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General Properties
The position where the object is placed and the size of the object can be controlled on the layout pane with the
mouse. Please refer to General Properties.（page 173 )

Structure Properties
Specifies the path of the XML data to be used for reference.

Properties Value Description

Repeat path The path of the element to be repeated The position in which data starts repeating is specified
by XML path.

Disable repeat Yes/No Sets whether to invalidate the repetition of data.

Refer to Properties that refer to the XML data（page 164 ) for more detailed information about the XML path.

Table that do not have repetition

Although tables are usually used to display data in the table by repeatedly processing the elements, you might
want to use a fixed table for layout purposes to arrange blocks of characters. In that case the Disable repeat property
should be set to "Yes."

Type Properties
Sets Type Properties such as the type of the object and the setting of the expression.

Properties Value Description

Language Conforms to the language codes Sets the language information that is then used to decide the
format for subsubtotal, subtotal, and total.

Country Conforms to the country codes Sets the country information that is used to decide the format for
subsubtotal, subtotal, and total.

Table Properties

Properties Value Description

Table type Fixed/Variable Table type can be specified as "Fixed" or "Variable."
However, because it is not possible to specify it in
the Properties window, please specify it by the Table
setup dialogue of Setting in the Table menu.

Background color 1 Hexadecimal RGB value starting
with #, or W3C color name.

Sets the background color of the odd number rows
of the table body.

http://lcweb.loc.gov/standards/iso639-2/iso639jac.html
http://www.iso.ch/iso/en/prods-services/iso3166ma/index.html
http://www.w3.org/TR/SVG11/types.html#ColorKeywords
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Background color 2 Sets the background color of the even number rows
of the table body.

Set Grouping None/Variable/Fixed Used to specify the Grouping function in table
object. "None" does not group cells. "Variable"
groups and merges cells when the same data appears
in consecutive cells in the same column. "Fixed"
groups cells by the number of Rows property
specified under Set Grouping. In this case cells are
not merged and the border line is drawn.

Rows arbitrary When Fixed is chosen the number of lines to be
grouped is specified.

Subsubtotal Yes/No Specifies whether to total by the unit of subsubtotal.

Subtotal Yes/No Specifies whether to total by the unit of subtotal.

Total Yes/No Specifies whether to total by the unit of total.

Column for the total Column number that corresponds
in table (counted from the left)

Specifies the target column for the total.

In addition to the table settings the following can be set for the subtotal, table processing and grand total properties.

Properties Value Description

Column number to judge
for break

Column number that corresponds in table (counted
from the left)

Specifies the column
number to be used as the
break key.

Page break Yes/No Specifies whether to create
a new page at the point of
break.

Title arbitrary Specifies the title that is
output for the total result.
The specified title is output
in the Title column.

Title column Column number that corresponds in table (counted
from the left)

Specifies the column that
displays (prints) the total
title.

Font family Select from the list The font to use for the total
result row.

Font size Numeric value (pt) The font size to use for the
total result row.

Format Conforms to Java.
Number, Currency, Date

The format to use for the
total result row.

Background color Hexadecimal RGB value starting with #, or W3C
color name.

The background color to
use for the total result row.

Fixed table and variable table

In a "Fixed" table the number of rows do not change according to the amount of data.

http://java.sun.com/j2se/1.5.0/docs/api/java/text/DecimalFormat.html
http://java.sun.com/j2se/1.5.0/docs/api/java/text/SimpleDateFormat.html
http://www.w3.org/TR/SVG11/types.html#ColorKeywords
http://www.w3.org/TR/SVG11/types.html#ColorKeywords
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A "Variable" table expands the number of rows according to the amount of data. The rows of the table body is
set by only one row in the layout pane.

Because each table can be set regardless of the layout type, how the report is layed out determines whether to use
a "Fixed" or "Variable" table.

Example of the background color for Table.

The background color for the table is set by the Background color dialogue.

Background color specifies the background color for the whole object of the table. Background color 1 can specify
the background color of the odd number rows of the table body. Background color 2 can specify the background
color of the even number rows of the table body. The priority level of Background color is; (1)table-cell,
(2)table-row,
(3)Background color 1 / Background color 2,
(4)table-body/header/footer,
(5)table.

This is an example of a table where the "Silver" color was specified as the Background color for the table, "Blue"
is set by Background color 1 and "Yellow" is set by Background color 2. The background color for the table
caption is set separately.
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Set Grouping

When the data that has the same content is used repeatedly in the same column, you can combine those cell together
in the output. This function is called "Grouping." Grouping controls whether cells are automatically merged to
create vertical spans. "Variable" groups and merges cells when the same data appears in consecutive cell of the
column. "Fixed" groups the specified number of rows and removes the border between them without merging the
rows.
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Which rows are brought together can be specified by the following two methods.

1. Change it in the Properties window

Select the target column in the layout pane, or select "column-info" in the Objects tree window.
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With the column (or "column-info") being chosen, open the Properties window and specify "Yes" or "No"
in the Grouping property.

2. Change it using the Table setup dialogue

Select the target table, and open the Table setup dialogue from Setting in the Table menu. Open Column
setting tab and choose the column that you want to apply Grouping to from the Column list and then check
"Grouping."

Counting the value in columns

The specified column is totaled at the level of subsubtotal, subtotal and total. The results are output to the column
specified by "Column for the total." At each level, the Title of the results can be output to the column specified
by the Title column. The font of the column that shows the title (font name and fontsize) and the format and the
background colors can also be set.
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Because the total result is output to a row that does not originally exist, the Set Grouping property specified by
"Fixed" is not available for this function.

You can set this property by Control break tab in the Table setup dialogue opened from the Setting of the Table
menu.

Text Properties
These are the properties that specifies the character format for the entire table.

Properties Value Description

Font family Select from the list The font family is set with the
Font dialogue. Each value set by
this dialogue is reflected in the
"Font size," "Font style" and
"Font effect" property.

Font size Numeric value (pt) Font size.

Font style Select from the list Font style is set by the font setting
dialogue.

Font effect Select from the list Font effect is set by the font
setting dialogue.

Text color Hexadecimal RGB value starting with #, or W3C color name. Text color.

Border Properties
Please refer to Border Properties. （page 181 )

Placing a diagonal line in a cell

A Diagonal line and a Reverse diagonal line in a cell have the properties of style, width and color.

http://www.w3.org/TR/SVG11/types.html#ColorKeywords
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The "Antenna House XSL Formatter V4.0" or later, or the "Antenna House AH Formatter V5.0" or later is
necessary to be able to preview, print and the produce PDF output with the diagonal and reverse diagonal lines.

Print Property
Please refer to Print Property. （page 182 )

22.5  Line object

This object is convenient when adding a simple horizontal or vertical line to the layout. A New line object can be
placed by selecting New line from the Object menu and making an object frame by using the mouse on the layout
pane. 

http://www.antennahouse.com/product/axfo40/axfo4top.htm
http://www.antennahouse.com/product/ahf50/ahf5top.htm
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The mark  in the upper left corner of the object frame is used to denote a line object.

Properties Value Description

Object type line The object type is line.

General Properties
The position where the object is placed and the size of the object can be controlled on the layout pane with the
mouse. Please refer to General Properties. （page 173 )

The background color property cannot be set for the line object.

Line Properties

Properties Value Description

Line direction None/Horisontal center/Vertical center/
Left-top to Right-bottom/Left-bottom to Right-top

The line direction of line
object.

Line style None/Solid/Dotted/Dashed The line style of line object.

Line width Numeric value (mm/in/pt) Width/thickness of the line.

Line color Hexadecimal RGB value starting with #, or W3C color name. The color of the line object.

The direction, style, width and color of object

The direction, style, width and color of the line object can be set freely.

Example of line objects

http://www.w3.org/TR/SVG11/types.html#ColorKeywords
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23   Properties list for .rxl file and .XSL file output
The following tables are the Properties list for each object and their level of support by the .rxl file and the .XSL
file (output). 

Level of Support Description

yes Both of .rxl file and .XSL file support it.

yes/no .rxl file supports it.
.XSL file does not support it.

yes(*) .rxl file supports it.
.XSL file supports it with limitation.

Property

Object

docum
ent

report-header/footer

page-header/footer

repeat

page

fram
e

label

text

im
age

barcode

table

caption

colum
n-info

table-header/footer/body

table-fow

table-cell

line

Object type yes/
no

yes/
no

yes/
no

yes/
no

yes/
no

yes/
no

yes/
no

yes/
no

yes/
no

yes/
no

yes/
no

yes/
no

yes/
no

yes/
no

yes/
no

yes/
no

yes/
no

Repeat path yes yes

Page break yes yes yes

Kind yes/
no

yes/
no

yes/
no

yes/
no

Variable
name

yes/
no
(*)

yes/
no
(*)

yes/
no
(*)

yes/
no
(*)

Data type yes/
no

yes/
no

XML path yes yes yes yes

Expression yes/
no
(*)

yes/
no
(*)

yes/
no
(*)

Format yes
(*)

yes
(*)

Language yes/
no

yes/
no

yes/
no

Country yes/
no

yes/
no

yes/
no

Property
expression

yes/
no
(*)

yes/
no
(*)

yes/
no
(*)

yes/
no
(*)

yes/
no
(*)

X yes yes yes yes yes

Y yes yes yes yes yes



Properties list

207

Width yes yes yes yes yes yes

Height yes yes yes yes yes yes yes yes yes yes

Print control yes yes yes yes yes yes yes

Linefeed
treatment

yes yes

White space
treatment

yes yes

Font family yes yes yes yes yes

Font size yes yes yes yes yes

Font style yes yes yes yes

Font effect yes yes yes yes

Vertical
script

yes yes yes

Text color yes yes yes yes yes

Background
color

yes yes yes yes yes yes

Horizontal
alignment

yes yes yes

Vertical
alignment

yes yes yes yes

Letter
spacing

yes yes

Line height yes yes

Top line
indent

yes yes

Left
padding

yes yes yes

Top padding yes yes yes

Right
padding

yes yes yes

Bottom
padding

yes yes yes

Overflow yes yes

Border left
style

yes yes yes yes yes yes yes yes yes yes yes yes

Border left
width

yes yes yes yes yes yes yes yes yes yes yes yes

Border left
color

yes yes yes yes yes yes yes yes yes yes yes yes

Border top
style

yes yes yes yes yes yes yes yes yes yes yes yes

Border top
width

yes yes yes yes yes yes yes yes yes yes yes yes
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Border top
color

yes yes yes yes yes yes yes yes yes yes yes yes

Border right
style

yes yes yes yes yes yes yes yes yes yes yes yes

Border right
width

yes yes yes yes yes yes yes yes yes yes yes yes

Border right
color

yes yes yes yes yes yes yes yes yes yes yes yes

Border
bottom style

yes yes yes yes yes yes yes yes yes yes yes yes

Border
bottom
width

yes yes yes yes yes yes yes yes yes yes yes yes

Border
bottom
color

yes yes yes yes yes yes yes yes yes yes yes yes

Diagonal
style

yes yes yes yes yes yes yes yes

Diagonal
width

yes yes yes yes yes yes yes yes

Diagonal
color

yes yes yes yes yes yes yes yes

Reverse
diagonal
style

yes yes yes yes yes yes yes yes

Reverse
diagonal
width

yes yes yes yes yes yes yes yes

Reverse
diagonal
color

yes yes yes yes yes yes yes yes

Layout type yes

Paper type yes

Reference
XML file

yes/
no

Comment yes/
no

Print page
header

yes

Print page
footer

yes

Include
page count

yes/
no

Reset page
number

yes/
no
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First page
number

yes/
no

Parent
repeat path

yes

Place yes

Keep
together

yes

Auto grow yes

Bottom line
alignment

yes

Overflow
replace

yes

Overflow
condense

yes

Image type yes

File path yes

Save full
path

yes

Scaling yes

dpi yes/
no

Clipping yes

Horizontal
alignment

yes

Vertical
alignment

yes

Barcode
value

yes

Barcode
type

yes

Barcode
function's
Java class
name

yes/
no

Start code yes

Stop code yes

Check digit yes

Aux yes

String type yes

Table type yes

Disable
repeat

yes
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Background
color 1

yes/
no

Background
color 2

yes/
no

Set
Grouping

yes/
no

Rows yes/
no

Subsubtotal/
Subtotal/
Total

yes/
no

Column
number to
judge for
break

yes/
no

Page break
(for
Subsubtotal/
Subtotal/
Total)

yes/
no

Title yes/
no

Title
column (for
the title)

yes/
no

Font family
(for
Subsubtotal/
Subtotal/
Total)

yes/
no

Font size
(for
Subsubtotal/
Subtotal/
Total)

yes/
no

Format (for
Subsubtotal/
Subtotal/
Total)

yes/
no

Background
color (for
Subsubtotal/
Subtotal/
Total)

yes/
no

Column for
the total

yes/
no

Caption side yes

Column
type

yes/
no
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Grouping yes/
no

Cell type yes/
no

Line
direction

yes

Line style yes

Line width yes

Line color yes

* Notes;

■ In XSL file the Format for numerical values is output. The Format for other types of data (i.e. for
dates) is output as a comment in the XSL file.

■ In XSL file the properties of "Set Grouping" and "Control break" for tables are not output.

■ In XSL file variable names and expressions are not output. They are output as comments in the XSL
file.

24  Properties list
This is the list of properties which can be specified in XSL Report Designer. 

Property Description

Object type Displays the name of the object.

Repeat path The position at which data starts repeating is specified by the XML path.

Page break Specifies whether to break a page at the end of the current object.

Kind The type of data is selected from "Field" or "Static." When "field" is selected
for text, image and barcode the data specified by the XML path will be
embedded.

Variable name Used to set a name to the object. The name set here can be referred to by
expressions in the project.

Data type The type of the text data according to the content can be either "String,"
"Number," "Currency" or "Date."

XML path Used to specify which part of the XML data is embedded. It becomes effective
when selecting "Field" in "Kind."

Expression This is set when the calculation or additional processing of the data is
necessary.

Format Used to set the format of "Number," "Currency" or "Date" which is set in
"Data type."

Language Sets language information used to control the formatting. In table object it
controls the formatting of the column that the total result is output.

Country Sets Country information used to control the formatting. In table object it
controls the formatting of the column that the total result is output.

Property expression This is set when dyanamic property changes are needed.
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X X-coordinate for the object. When a margin is displayed the X coordinate is
measured from the from the left margin. If no margin is displayed it is
measured from the left edge of the page, frame or label.

Y Y-coordinate for the object. When a margin is displayed the Y coordinate is
measured from the from the top margin. If no margin is displayed it is
measured from the top edge of the page, frame or label.

Width The width set for the object.

Height The height set for the object.

Print control
■ Print

Prints according to the setting.

■ Value only
Prints only the value and not the frame. This is used with pre-printed
forms.

■ Not
It doesn't print regardless of the setting.

Linefeed treatment
■ Ignore

Ignore linefeed.

■ Preserve as linefeed
Changes line at the linefeed code position.

■ Treat as space
Treats the linefeed code as a space.

■ Treat as zero width space
Treats the linefeed code as a zero width space.

White space treatment
■ Ignore

Ignore white space.

■ Preserve as white space
The space is put in the code position of the white space.

■ Ignore if before linefeed
The space before the linefeed code is ignored.

■ Ignore if after linefeed
The space after the linefeed code is ignored.

■ Ignore if surrounding linefeed
The blank before and behind the linefeed code is ignored.

Font family The font family is set by the font setting dialogue. Each value set by this
dialogue is reflected in "Font size," "Font style" and "Font effect" property.

Font size Font size is set.

Font style Font style is set by the font setting dialogue.

Font effect Font effect is set by the font setting dialogue.

Vertical script Sets for vertical writing mode.

Text color Sets text color.

Background color Sets the background color of the object area defined by the rectangle.
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Horizontal alignment Sets how the string is arranged horizontally in the rectangular area of the
object.

Vertical alignment Sets how the string is arranged vertically in the rectangular area of the object.

Letter spacing Sets the letter spacing.

Line height Sets the line height.

Top line indent Sets the amount of the indent of the first line.

Left padding Sets the amount of space between the left edge of a rectangular area of an
object and the text.

Top padding Sets the amount of space between the top edge of a rectangular area of an
object and the text.

Right padding Sets the amount of space between the right edge of a rectangular area of an
object and the text.

Bottom padding Sets the amount of space between the bottom edge of a rectangular area of an
object and the text.

Overflow Sets how to process text when it exceeds the display area of an object. It is
effective when "Auto grow" property is set to "No."

■ Hidden
The overflowing part is not printed.

■ Replace
The character string set to "Replace" is printed. It is embedded
repeatedly until this character string fills the area.

■ Condense
It is condensed based on the method set by "Overflow condense."

Border style Sets the style of each border line individually.

Border width Sets the width of each border line individually.

Border color Sets the color of each border line individually.

Diagonal (Reverse diagonal)
style

Sets the style of Diagonal (Reverse diagonal).

Diagonal (Reverse diagonal)
width

Sets the width of Diagonal (Reverse diagonal).

Diagonal (Reverse diagonal)
color

Sets the color of Diagonal (Reverse diagonal).

Layout type The layout type set for the project is displayed. It cannot be changed.

Paper type The paper type set for the project is displayed.

Reference XML file The XML file that is used for structure reference for the project is displayed.

Comment The comment character string of the project can be freely described.

Print page header Sets whether to print page header on report header/footer.

Print page footer Sets whether to print page footer on report header/footer.

Include page count Sets whether to include report header/footer in the page count.

Reset page number Sets whether to initialize the page number for each repeat.

First page number Sets the first page number.
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Parent repeat path The repeat path set to the parent repeat is displayed. When the value is
changed, it is reflected in the property of the repeat.

Place Sets the arrangement of the frame objects.

■ Fixed
Beginning Y-coordinates of the object can be set by the absolute
coordinate from the top of the frame. However, the length of the frame
doesn't change even if the length of the object expands.

■ Flow
When the length of the object expands, the length of other objects and
frames expand accordingly. This does not apply if the objects are
arranged in succession horizontally.

Keep together The objects in the frame are arranged on the same page.

Auto grow Sets whether to extend object according to volume of data.

Bottom line alignment Sets the horizontal alignment of the final line.

Overflow replace Sets the replacement character string for "Replace" in "Overflow."

Overflow condense Sets the processing for "condense" in "Overflow."

■ Condense font size
Adjusts font size to condense.

■ Condense letter spacing
Adjusts character space to condense.

■ Condense word spacing
Adjusts word space to condense.

■ Condense font stretch
Adjusts font stretch to condense.

■ Condense line height
Adjusts line height to condense.

■ Auto
Depends on the default of the system.

Image type Specifies what type image is selected; "BITMAP," "JPEG," "JPEG2000,"
"PNG," "TIFF," "GIF" and "SVG."

File path Path of the image file is set for "Static" in the Kind property.

Save full path Sets whether to save full path to the image. If set to "No," a relative path is
saved.

Scaling Sets how to expand, contract and place the image.

■ Fit horizontal
Holds the ratio of length to width and then fits to the width of the frame.

■ Fit vertical
Holds the ratio of length to width and then fits to the length of the frame.

■ Fit to box
Does not hold the ratio of length to width and then fits to the frame size.
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■ Fit to image size
Sets the size specified by the image data. (Only for Vector graphics)

■ dpi
It matches the dpi specified. (Only for Raster graphics)

dpi Sets the dpi value for "dpi" in "Scaling."

Clipping Whether to do clipping (maintain image size, but trim to fit the frame). "Clip"
keeps the image from overflowing the frame.

■ Clip
Keeps the image from overflowing the frame.

■ No clip
Image overflows sides of the frame.

■ Fit to image
Sets the frame size to fit the size of the image. Can only be used for
Vector graphics or when "dpi" is set in the Scaling property.

Horizontal alignment Sets the horizontal axis position "left," "right," "center" for the frame.

Vertical alignment Sets the vertical axis position to "top," "bottom," "center" for the frame.

Barcode value Sets the data displayed as a barcode. It is effective only when "Static" is set
in "Kind."

Barcode type The type of the barcode is selected from CODE39, CODE128, CODABAR,
EAN, EAN128, ITF, JAN, POSTNET, UPC-A, UPC-E, and others.

Barcode function's Java class
name

Sets the complete barcode function's Java class name that processes the bar
code.

Start code Sets the start code for the barcode. Even if it is set there are cases where it will
be ignored by the classification of the barcode.

Stop code Sets the stop code for the barcode. Even if it is set there are cases where it will
be ignored by te classification of the barcode.

Check digit Sets whether to put the check digit on the barcode. Even if it is set there are
cases where it will be ignored by the classification of the barcode.

Aux This is the supplementary parameter used to generate the barcode. The usage
differs by the barcode used and the program (Java class name of the bar code
processing) that processes the barcode.

String type String type property specifies what kind of string is generated as a barcode
string from the data. "font-code" is usually specified when you want to output
the vertical stripes of the barcode by specifying the bar code font. "code-value"
is specified when the output that is generated contains automatically created
start codes, etc. in the character string. This helps when debugging the
barcodes. If the vertical stripes of the barcode do not display correctly, please
check to make sure that the correct barcode font which has "font-code" as the
property is specified.

Table type
■ Fixed

In a "Fixed" table the number of rows do not change according to the
amount of data.

■ Variable
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A "Variable" table expands the number of rows according to the amount
of data. The rows of the table body is set by only one row in the layout
pane.

Disable repeat Whether to invalidate the repetition of data by disabling it.

Background color 1 Sets the background color for the odd number rows of the table body.

Background color 2 Sets the background color for the even number rows of the table body.

Set Grouping When the data that has the same content is used repeatedly in the same column,
you can combine those cell together in the output.

■ None
Does not group cells.

■ Variable
Groups and merges cells when the same data appears in consecutive
cells of the column.

■ Fixed
groups cells by the number of Rows property specified under Set
Grouping. In this case cells are not merged and the border line is drawn.

Rows When Fixed is chosen the number of lines to be grouped is specified.

Subsubtotal/Subtotal/Total When you set Grouping, specify at which level the grouping is set.

Column number to judge for
break

Sets the column number to be used as the break key for grouping.

Page break (for Subsubtotal/
Subtotal/Total)

Sets whether to change page when the break happens.

Title Specifies the title that is output for the total result. The specified title is output
in the Title column.

Title column Sets the column for the title.

Font family (for Subsubtotal/
Subtotal/Total)

Sets the font of the total result row.

Font size (for Subsubtotal/
Subtotal/Total)

Sets the font size of the total result row.

Format (for Subsubtotal/
Subtotal/Total)

Sets the format of the total result row.

Background color (for
Subsubtotal/Subtotal/Total)

Sets the background color of the total result row.

Column for the total Sets the column that the total result is output to.

Caption side Sets whether to put the caption "Above" or "Below" the table.

Column type The objects put in the column of the table-body is selected from "Text,"
"Image" and "Barcode."

Grouping Whether Grouping of each column is set is specified. This check box is
available only when "Set Grouping" property is specified for "Variable" or
"Fixed." Even if the "Set Grouping" in the Table setting tab is set the Grouping
is not available unless this item is checked.

Cell type The kind of object specified for the cell is displayed. This is the same kind as
specified for the column and it is not possible to change.

Line direction Sets the line direction of Line object.
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Line style Sets the line style of Line object.

Line width Sets the line width of Line object.

Line color Sets the line color of Line object.
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25  The list of Built-in Functions
The Built-in Functions that can be used by the expression of XSL Report Designer is as follows. 

Feature Function Parameter Returned
value

Description

Return the
absolute
value

abs(numerical value) Numerical value to find
the absolute value.

numerical
value

Return the absolute value
of the numerical value
specified by the parameter.

Return
TRUE(1)
when two
parameters
are
TRUE(1).

and(logical expression
1,logical expression 2)

logical expression 1
logical expression 2

TRUE(1),
FALSE(0)

Return TRUE(1) when two
parameters are TRUE(1).
Return FALSE(0) when
either of two parameters is
FALSE(0).

Check string
occurrence

contains(character string
1, character string 2)

character string 1
character string 2

TRUE(1),
FALSE(0)

Check whether or not the
specified character string 1
contains the specified
character string 2.
Return TRUE(1) if
character string 1 contains
character string 2,
FALSE(0) otherwise.

Return the
current page

currentPage() - Character
string
(String)

Return <fo:page-number/>
that means a current page
within the fo.

Return the
current date

date(format, country,
language)

format character string
country character string
language character string

Character
strings
(String)

Output the current date in
the format that is specified
by format.

Convert the
date into
character
string

date2str(Date) Date; The date
(Numerical value) to
convert into character
string.

Character
string

The date character string is
output at the specified date.
The date character string is
the form of YYYY/MM/
DD. The numerical value at
the specified date is GMT
January 1st of 1970,
00:00:00.

Calculate the
date

dateCalc(Date character
string, Calculation field,
Calculation value)

Date character string;
Specify the date character
string to calculate.
Format should be YYYY/
MM/DD.
Calculation field; Specify
the field to calculate.
Format should be
YEAR,MONTH,DATE.
Calculation value;
Specify the value to
calculate. The minus is
applied to the numerical
value to subtract.

Character
string
(String)

The calculation value is
added to specified field
(YEAR,MONTH,DATE)
of the date specified by the
parameter. The calculation
result returns by the
character string in the form
of YYYY/MM/DD.
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Compare
character
strings.

exact(character string 1,
character string 2)

character string 1
character string 2

TRUE(1),
FALSE(0)

Return TRUE(1) when the
specified character strings
are equal.
Return FALSE(0), when
the specified character
strings are not equal.

Acquire the
col number

getColNo() - Numerical
value

Acquire the col number in
the table. The col numbers
start from 1.

Return a
record
number.

getRecNo() - numerical
value

Return a record number.

Return a
repeat
number.

getRepeatRowNo() - numerical
value

Return a current repeat
number.

Acquire the
row number

getRowNo() - Numerical
value

Acquire the row number in
the table. The row numbers
start from 1.

Return the
value of a
current
object.

getThisValue() - character
string

Return the value of a
current object.

Return the
average
value

hAvg() - Numerical
value
(double
precision)

Return the average value of
horizontal cells. Cells to
the left of the cell that has
hAvg-function are
calculated. When the data
type of the cell is character
or there is no data in the
cell, it is not included in the
calculation.
Note)

Return the
number of
cases

hCount() - Numerical
value
(double
precision)

Return the number of cases
in the horizontal cell. Cells
to the left of the the cell that
has hCount-function are
calculated. When the data
type of the cell is character
or there is no data in the
cell, it is not included in the
calculations.

Return the
total

hSum() - Numerical
value
(double
precision)

Return the total in the
horizontal cell. Cells to the
left of the the cell that has
the hSum-function are
calculated. When the data
type of the cell is character
or there is no data in the
cell, it is not included in the
calculations.

Processing is
distributed

if(logical expression, true
case, false case)

logical expression
true case
false case

The value
specified
in the case

Processing is distributed to
a true case and a false case
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by the logical
expression.

of the true
and the
false

by evaluating of the logical
expression.

Index of
string

indexOf(character string 1,
character string 2)

character string 1
character string 2

Numerical
value

Return the index within the
specified character string 1
of the first occurrence of
the specified character
string 2.
Returned index value starts
from 1.
-1 is returned if the
character string 2 is not
substring of the character
string 1.

Last index of
string

lastIndexOf(character
string 1, character string 2)

character string 1
character string 2

numerical
value

Return the index within the
specified character string 1
of the last occurrence of the
specified character string 2.
Returned index value starts
from 1.
-1 is returned if the
character string 2 is not
substring of the character
string 1.

Match of
string

matches(string, regex) string
regex

TRUE(1),
FALSE(0)

Check whether or not the
specified string matches
the specified regular
expression.
Return TRUE(1) if
matched, FALSE(0)
otherwise.
It is the same as the
matches method of the
String class of Java.

Return the
length of the
character
string

length(character string) Character string Numerical
value
(double
precision)

Return the length of
character strings of
parameter. It is the same as
the length method of the
String class of JAVA.

Return larger
numerical
value.

max(numerical value 1,
numerical value 2)

numerical value 1
numerical value 2

numerical
value

Return the larger of two
specified numerical values.

Return
smaller
numerical
value.

min(numerical value
1,numerical value 2)

numerical value 1
numerical value 2

numerical
value

Return the smaller of two
specified numerical values.

Return
FALSE(0)
when the
parameter is
TRUE(1),
and return
TRUE(1)
when the

not(logical expression) logical expression TRUE(1),
FALSE(0)

Return TRUE(1) when the
logical expression is
FALSE(0), and return
FALSE(0) when the logical
expression is TRUE(1).
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parameter is
FALSE(0).

Convert the
numerical
value into the
character
string

num2str(Numerical value) Numerical value
converted into character
string

Character
string
(String)

Return
TRUE(1)
when either
of two
parameters is
TRUE(1).

or(logical expression 1,
logical expression2)

logical expression 1
logical expression 2

TRUE(1),
FALSE(0)

Return TRUE(1) when
either of two parameters is
TRUE(1). Return
FALSE(0) when two
parameters are FALSE(0).

Return the
total of
records

recSum(name) Specify the name with
character string

Numerical
value
(double
precision)

Return the total specified
by the name.
Cleared for each record.

eReturn the
remainder.

remainder(numerical
value 1,numerical value 2)

numerical value 1
numerical value 2

numerical
value

Return the remainder of
(numerical value 1 /
numerical value 2). Same
as % in Java.

All
replacement
of string

replaceAll(string, regex,
replacement)

string
regex
replacement

Character
string
(String)

Replace each substring of
the specified string that
matches the specified
regular expression with the
specifed replacement.
It is the same as the
replaceAll method of the
String class of Java.

Replacement
of string

replaceFirst(string, regex,
replacement)

string
regex
replacement

Character
string
(String)

Replace the first substring
of the specified string that
matches the specified
regular expression with the
specifed replacement.
It is the same as the
replaceFirst method of the
String class of Java.

Set object
property.

setProp(property name,
property value)

property name character
string
property value character
string

- Set the specified property
value to the specified
property.

Set property
of the object
pointed by
variable.

setPropByName(variable
name, property name,
property value)

variable name character
string
property name character
string
property value character
string

- Set the specified property
value to the specified
property of the object
pointed by the specified
variable.

Set object
properies by
using
property
group.

setProps(property group
name)

property group name
character string

- Set object properties by
using the specified
property group.
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Set
properties of
the object
pointed by
variable by
using
property
group.

setPropsByName(variable
name, property group
name)

variable name character
string
property group name
character string

- Set properties of the object
pointed by the specified
variable by using property
group.

Convert the
character
string into
the date

str2date(Date character
string, Format character
string)

Date character string; The
charactes string to
convert into the date.
Format character string;
Format to do parsing.

Numerical
value

The return value is the
millisecond from GMT
January 1st of 1970,
00:00:00.

Convert the
character
string into
the
numerical
value

str2num(Character string) Character string
converted into numerical
value

Numerical
value
(double
precision)

Return the
substring

substring(Character string,
Starting position)

Character string
Starting position (The
head position is 1.)

Character
string
(String)

Return the character string
from the starting position
of the specified character
string.

Return the
substring

substring(Character string,
Starting position, Number
of character)

Character string
Starting position (The
head position is 1.)
Number of character

Character
string
(String)

Return the character string
from the starting position
of the specified character
string to the number of
characters.

Return the
current time

time(format, country,
language)

format character string
country character string
language character string

Character
strings
(String)

Output the current time in
the format that is specified
by format.

Convert the
character
string to the
lowercase
letter

toLowerCase Character string
converted to the
lowercase letter

Character
string
(String)

Convert the character
string to lowercase letters.

Return the
number of
total pages

totalPages() - Character
string
(String)

Return <fo:page-number-
citation id-ref="rx-page-
number-citation-last-
page" />

Return the
final total

totalSum(name) Specify the name by the
character strings

Numerical
value
(double
precision)

Return the final total of the
numerical value for a
specified named variable.

Convert the
character
string to the
uppercase
letter

toUpperCase Character string
converted to uppercase
letter

Character
string
(String)

Convert the character
string to the uppercase
letters.

Return the
average
value

vAvg() - Numerical
value
(double
precision)

Return the average value of
vertical cell. Only
numerical value in cell are
calculated.
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Note) This is effective only
on the table on which the
consistent repeat is
specified.

Return the
number of
cases

vCount() - Numerical
value
(double
precision)

Return the number of cases
in the vertical cell. Only
numerical value in cells are
included.
Note) This is effective only
on the table on which the
consistent repeat is
specified.

Return the
total

vSum() - Return the total for the
vertical cell. Only
numerical values in cell are
included.
Note) This is effective only
on the table on which the
consistent repeat is
specified.

Acquire the
data from
XML data

XPath(xpath) xpath string:Relative path
from the path of ancestor
object.

Character
string
(String)

The XML data is extracted
based on the location path
specified with xpath. The
location path is a relative
path from an ancestor
object. Restrictions: The
first data is extracted when
the table and the repeat
have repetition.

Acquire the
data from
XML data

XPathEx(xpath) xpath string: Relative
path from the main
repeat.

Character
string
(String)

The XML data is extracted
based on the location path
specified with XPathEx.
The location path is
referred from the
subordinate position of the
main repeat. Restrictions:
The first data is extracted
when the table and the
repeat have repetition.

Note)
The calculation by this expression is effective in only the table for which the repetition is specified without
contradiction. To use v*** expression in the table, it needs to consistent with the following conditions.
(1) Specify "No" to "Disable repeat" in table property.
(2) XML path is required to be set in order of Document→Repeat→Table(Repeat path)→Cell without
contradiction.
(3) XML path specified for the cell of the same column must be all the same.
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The Runtime Engine merges the project (layout) created with XSL Report Designer and your XML data to produce
XSL-FO for creating screen, PDF or print files with Antenna House XSL Formatter or AH Formatter.

The following description of the Runtime Engine and how to implement it within an applications is written with
assumptions that the reader has knowledge of the Java language, the programming, the start method, etc.. An
understanding of Java is necessary before referring to these pages.

26   Operating Environment
It is necessary to install the execution environment of Java.
The environment of J2SDK1.5/JRE1.5 or higher is required.

27   Start by batch file
Antenna House provides the batch file "rxe.bat" for Windows, and the shell script "rxe.sh" for UNIX in the installed
"bin" folder.
Please set environment variable "JRE_HOME" and "RXE_HOME" through the command mode.

Here is the Windows example:

■ Example of setting environment variable.
set JRE_HOME=c:/C:\jdk1.5.0_08/jre/bin
set RXE_HOME=c:/Program files/Antenna/XSLReportDesignerV25

■ Example of using .bat:
rxe -layout mylayout.rxl -output mylayout.fo mydata.xml

In the above, "mylayout.rxl" is specified as project file,
"Mylayout.fo" is specified as an output file name, and "mydata.xml" is specified as XML data.

Start Option

-layout This specifies project file.

-error This specifies error file. If this is omitted, then the error messages will be output to standard
error.

-output This specifies output file. If this is omitted, then FO will be output to stardard output.

-verbose This specifies verbose mode.

XMLDataFile This specifies input XML data file. If this is omitted, then standard input will be used.

28   Command Line Interface
It's possible to start with a command line and specify the class of the runtime engine for the Java interpreter. It is
assumed that java command is in the command search path.
It is also necessary to specify all jar files such as rxe.jar which are included in XSL Report Designer for
CLASSPATH to execute it. (Or, please specify it by the parameter of "-cp" of Java option.) These jar files are in
lib folder of the XSL Report Designer installation directory.
Please refer to rxe.bat or rxe.sh for the actual start method.

■ How to call it.
java jp.co.antenna.rx.rxe.rxe -layout LayoutFile [-error ErrorFile] [-output OutputFile] [XMLDataFile]

Start Option

-layout This specifies project file.
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-error This specifies error file. If this is omitted, then the error messages will be output to standard
error.

-output This specifies output file. If this is omitted, then FO will be output to stardard output.

-verbose This specifies verbose mode.

XMLDataFile This specifies input XML data file. If this is omitted, then standard input will be used.

Return value

When it is a normal termination, 0 is returned. When it is not a normal termination, it returns the value excluding
0.

29   Java Interface
You can use runtime engine directly from your Java programs.

29.1  rxe

"rxe" is a class for using the runtime engine from Java.
The runtime engine can be executed by using the start option in the command line interface as a parameter.

Here is the sample code.
It is necessary to specify rxe.jar for CLASSPATH to compile.
It is necessary to specify all jar files which are included in XSL Report Designer for CLASSPATH to execute it.
(Or, please specify it by the parameter of "-cp" of Java option.) These jar files are in "lib" folder of the XSL Report
Designer installation directory.

// import XSL Report Designer classes
import jp.co.antenna.rx.rxe.*;

public class TestRxe {
    public static void main(String[] args) {
        // create rxe object.
        rxe myRxe = new rxe();

        // setting up parameters.
        String [] params = new String[3];
        params[0] = "layout.rxl";
        params[1] = "output.fo";
        params[2] = "xmldata.xml";

        // execute(generate) XSL-FO.
        boolean rslt = myRxe.subMain(params);

        // print result
        if (rslt) {
            System.out.println("OK");
        } else {
            System.out.println("NG");
        }
    }
}

Here is the API for rxe.

rxe
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public rxe()
constructor.

subMain
public boolean subMain(java.lang.String[] argv)

sub main entry.subMain is commonly used rather than main.

■ parameters:

argv - command line options.

■ return value:

true if success, false if fail.

main
public static void main(java.lang.String[] args)

main entry.
subMain is commonly used rather than main. You should use this carefully because this will call
System.exit().
And it's exit code is: 0 if success. 1 if fail.

■ parameters:

args - command line options.

29.2   RxEngine

"RxEngine" is a class to use the runtime engine from Java.
Differing from "rxe" that uses the start option in the command line interface as a parameter, "RxEngine" can do
a more detailed control than "rxe" by using the method.

Here is the fragment of the sample code.
It is necessary to specify rxe.jar for CLASSPATH to compile.
It is necessary to specify all jar files which are included in XSL Report Designer for CLASSPATH to execute it.
These jar files are in "lib" folder of the XSL Report Designer installation directory.

// import XSL Report Designer classes
import jp.co.antenna.rx.rxe.*;

public class TestRxEngine {
    public static void main(String[] args) {
        // create RxEngine object.
        RxEngine eng = new RxEngine();

        // setting up parameters.
        eng.setLayoutLocation("layout.rxl");
        eng.setOutputLocation("output.fo");
        eng.setXMLDataLocation("xmldata.xml");

        // execute(generate) XSL-FO.
        boolean rslt = eng.execute();

        // print result
        if (rslt) {
            System.out.println("OK");
        } else {
            System.out.println("NG");
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        }
    }
}

Here is the API for RxEngine.

RxEngine
public RxEngine()

constructor.
setLayoutLocation
public void setLayoutLocation(java.lang.String location)

Sets project file location.

■ parameters:

location - fullpath, filename, or complete URL.

setXMLDataLocation
public void setXMLDataLocation(java.lang.String location)

Sets location of XML data file.
If neither setXMLDataLocation nor setXMLDataStream is set, then the XML data is received from a
standard input.

■ parameters:

location - fullpath, filename, or complete URL.

setXMLDataInputSource
public void setXMLDataInputSource(org.xml.sax.InputSource inputSource)

Sets input source of XML data file.
If neither setXMLDataLocation nor setXMLDataInputSource is set, then the XML data is received from
a standard input.
Please refer to InputSource of org.xml.sax of J2SDK API for InputSource.

■ parameters:

inputSource - input source

setOutputLocation
public void setOutputLocation(java.lang.String location)

Sets output location.
If neither setOutputLocation nor setOutputStream is set, then XSL-FO is output to a standard output.

■ parameters:

location - fullpath or filename.

setOutputStream
public void setOutputStream(java.io.OutputStream outStream)

Sets output stream.
If neither setOutputLocation nor setOutputStream is set, then XSL-FO is output to a standard output.

■ parameters:

outStream - output stream.

setErrorLocation
public void setErrorLocation(java.lang.String location)

Sets error output location.

■ parameters:
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location - fullpath or filename. If this is null then the standard error will be assumed.

setLogger
public void setLogger(java.util.logging.Logger logger)

Sets logger.
You can set various options to the logger. It means that this method provides more flexible logging
facility than setErrorLocation.

■ parameters:

logger - Java standard Logger object.

getLogger
public RXLogger getLogger()

Gets logger.
The RxLogger is subclass of Java standard Logger.

■ return value:

RxLogger

setVerbose
public void setVerbose(boolean flag)

Sets verbose mode. The default value is false.

■ parameters:

flag - true: verbose, false: non-verbose.

setNoWarning
public void setNoWarning(boolean flag)

Sets no warning mode. If the value is true then warning output will be suppressed.
The default value is false.

■ parameters:

flag - true: no warning mode, false: warning mode.

setStartPos
public void setStartPos(int x, int y)

Sets the print start position when the layout type is label.
For example, if the paper divided by 5 rows and 2 columns as follows:

      0         1
+---------------------+
|+--------+ +--------+|
||        | |        || 0
|+--------+ +--------+|
|+--------+ +--------+|
||        | |        || 1
|+--------+ +--------+|
|+--------+ +--------+|
||        | |        || 2
|+--------+ +--------+|
|+--------+ +--------+|
||        | |    S   || 3
|+--------+ +--------+|
|+--------+ +--------+|
||        | |        || 4
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|+--------+ +--------+|
+---------------------+
setStartPos(1, 3) sets the print start position at the label marked 'S'.
The value is 0 origin.
This method valid only when the layout type is label.

■ parameters:

x - horizontal start position.

y - vertical start position.

setRecordBuffers
public void setRecordBuffers(int n)

Sets the number of record buffer.
If you set a large number to parameter 'n' then the processing speed of runtime engine may increase,
because the data reading thread will read more data at once. But it may cause out of memory error.
The default value is 100.

■ parameters:

n - the number of buffer.

execute
public boolean execute()

Executes generating FO.
Before calling this method, you must call setLayoutLocation, setXMLDataLocation,
setXMLDataInputSource, setOutputLocation, setOutputStream etc. according to your needs.
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30   Sample file list
Sample files are stored in the "Sample" folder of the installed folder. Sample files in Japanese are in the "Sample/
Japanese" folder and there are sample files in English in the "Sample/English" folder.

Layout Type Sample project file Sample XML file

Fixed Type order-fix.rxl / order-fix2.rxl sample-data.xml

Flow Type order-flow.rxl

Label Type label.rxl

Also, there are the following sample.

Function Sample project file Sample XML file

Barcode barcode-flow-repeat.rxl barcode-data.xml

Expression exp-sample1.rxl
exp-sample2.rxl

sample-data.xml
seiseki.xml

Control breaking and Collect c-break.rxl ctrl-break.xml

Sort and Grouping sort-group.rxl sort-group-data.xml

Dynamic property change dyna-prop-fix.rxl
dyna-prop-flow.rxl
dyna-prop-order-flow.rxl

dyna-prop-seiseki.xml
dyna-prop-seiseki.xml
sample-data.xml

In each sample, the following functions are used.

Function Discription

Report Header/Report Footer Using a Report Header/Report Footer.

Page Header/Page Footer Using a Page Header/Page Footer.

Font style (Font, Bold, Italic, Size, Underline, Color) Each font style can be specified for object.

Background color Background color can be specified for object.

Horizontal alignment/Vertical alignment You can arrange the position of each object. (In a left/
left/center or top/bottom/middle.)

Border (Style, Width, Color) You can choose the style, width, and color for the border
of each object.

Expressions A total of a vertical, horizontal numerical value, a
current date, and the page number, etc. are output by the
expression.

Property expressions The properties of objects(text color and background
color etc.) can be changed dynamically.

31   For Fixed layout type
"order-fix.rxl" is the sample of a fixed layout type. This is a typical form for printing. On the GUI of XSL Report
Designer, you can put each object at a fixed position in the area that is called a page. (On the GUI screen, the page
looks like a piece of paper.) The part for the margins and page header / footer are text areas that are excluded from
the paper.
The page header / footer and the report header / footer can be specified. Report header / footer always creates new
pages. This effectively applies a cover page to the report.
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31.1   Sample Project File (order-fix.rxl)

When you choose "Static" in "Kind," the static character strings are always displayed.
In the sample file, "Order Form" , "Antenna House,Inc." and so on are static.
When you choose "Field" in "Kind," the reference data specified by XML path will be embedded. In the sample
file, you can see "A" for the field. The cell of table is the same.
When you newly insert Table Objects dialogue for Table setup is shown. In this sample, we choose "Fixed" table
which has the fixed number of rows (8) and columns (6). You can see it on "Table setup" dialogue opened from
"Setting" of "Table edit" of "Object" menu.
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31.2   Result FO File (order-fix.fo)

Combining with "sample-data.xml," this project file is outputted as the following formatted FO file: (Note:
Antenna House XSL Formatter or AH Formatter was used to do the formatting)

By embedding corresponding data from XML file, "Field" areas now have data from the XML file.
As to the Fixed table, the table always keeps specified number of lines and columns.
If there are eight records in the repeat path, eight rows are full.
When there are more than eight records the additional lines will not be printed.

31.3   Result FO File2 (order-fix2.fo)

As you see in the sample of "order-fix2.rxl," one record of the database can compose multiple pages.
For instance, in the order form, the customer's information is in the first page and the second piece can be the
form and more details.
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32   For Flow Layout type
"order-flow.rxl" is the sample of Flow type.
This is the layout type where the object expands and contracts automatically based on the inside data.
You can arrange each object in the area that is called a frame. Multiple frames can be used and the objects can be
grouped within frames. By making groups the objects in that group are able to flow as one mass. The page header /
footer and the report header / footer can be specified. The layout can not be composed of multiple pages.
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32.1   Sample Project File (order-flow.rxl)

In this sample, there are 5 frames. One is for the "Company Profile." The next is for the data of "November
Customers."
The 3rd, 4th and 5th frames are in the "subrepeat" and are for the order information and the orderlist (table) of
"November Customers."(The 5th frame is used for interval adjustment of next repeat.)
By seeing the "Objects tree" it would be easy to see the entire structure of this sample.
The first two frames appear once and are not repeated. The other 3 frames are repeatable depending on the number
of orderlist in the XML file. We also use a "Variable" table which has 6 columns. How many rows appear depends
on the XML data.
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32.2   Result FO File (order-flow.fo)

Combining with "sample-data.xml," this project file creates the following output:

As you see from the above, the table expands and contracts according to the number of lines of data.
The position of the following objects changes accordingly. That is why it is called the flow type because the
objects flow.

33   For Label Layout type
Label type looks a lot like a Fixed type. The big difference is that Label type can divide the page vertically and
horizontally and the object is arranged in the one area. It is used when multiple records are sequentially printed
on one form, The object of a fixed position and a fixed size can be arranged.

In the sample project file, "label.rxl," the page was devided in 5 lines (rows) and 2 columns. You can specify
those in the dialogue of "Page setup."
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33.1   Sample Project File (label.rxl)

33.2   Result FO File (label.fo)

Combining with "sample-data.xml," this project file produces the following output:
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34   Sample for Barcode
Note;
XSL Report Designer uses the font installed by the XSL Formatter Barcode Option or the AH Formatter
Barcode Option. Please make sure that XSL Formatter Barcode Option is installed with your XSL Formatter,
or AH Formatter Barcode Option is installed with your XSL Formatter.

34.1   Sample Project File (barcode-flow-repeat.rxl)

Barcode object is used for the print of the barcode. You can put Barcode object, then specify the type and the font
etc. of the barcode in property.

34.2   Result FO File (barcode-flow-repeat.fo)

Combining with "barcode-data.xml," this project produces the following output:

http://antennahouse.com/product/barcode.htm
http://antennahouse.com/product/barcode.htm
http://antennahouse.com/product/barcode.htm
http://antennahouse.com/product/barcode.htm
http://antennahouse.com/product/barcode.htm
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35   Sample for Expression
By setting the expression you can easily set a complex expression to automatically input the date, page number,
column totals and so on. Please refer to the "Built-in Functions" for the available expressions.

35.1   Sample Project File (exp-sample2.rxl)

This sample uses the following built-in functions.

■ hAvg

■ totalSum

■ date

■ time

■ currentPage

■ totalPages

■ dateCalc
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35.2   Result FO File (exp-sample2.fo)

Combining with "seiseki.xml," this project produces the following output:
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36   Sample for Control break and Grouping
Control break is a function that totals the content of cells by the specified "Column number to judge for break."
When the data that has the same content is used consecutively in the same column, you can bring those cell together
and output it. This function is called Grouping. In the Set Grouping property, "Variable" groups and merges cells
when the same data appears in the consecutive cell of the column. "Fixed" groups cells by the number of Rows
property specified under Set Grouping. In this case, cells are not merged, and the border line is drawn.
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36.1   Sample Project File (c-break.rxl)

36.2   Result FO File (c-break.fo)

Combining with "ctrl-break.xml," this project file produces the following output:
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 Revision
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The revision history of XSL Report Designer is as follows.

37   V2.5 MR4 (Released on January 26, 2012)
The following functions were added.

1. Corrected an issue where an error would occur while previewing the document when 32bit AH Formatter/
XSL Formatter were installed on Windows 64bit.

38   V2.5 MR3 (Released on October 17, 2011)
The following functions were added.

1. Corresponds to AH Formatter V6.

39   V2.5 MR2 (Released on December 24, 2009)
The following functions were added.

1. When there was an expression in the text frame, the stylesheet was not outputted.

40   V2.5 MR2 (Released on November 24, 2009)
The following functions were added.

1. Some attributes of the text frame were not corresponded with the stylesheet output.

41   V2.5 MR2 (Released on October 21, 2009)
The following functions were added.

1. Corresponds to Windows 7.

42   V2.5 MR1 (Released on July 29, 2007)
The following functions were added.

1. Corresponds to AH Formatter V5.

43   V2.5 (Released on January 28, 2007)
The following functions were added.

1. The ability to use PDF as a base draft is added.
2. The ability to change the properties of objects dynamically.
3. Adds string related functions.

44   V2.1 (Released on June 1, 2007)
The following functions were added.

1. The ability to merge cells of the table is added.
2. The featrure to stick objects is added to the editing functions.
3. The ability to group objects is added.
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45   V2.0 MR4 (Released on March 5, 2007)
The following functions were added.

1. Corresponds to Windows Vista.

46   V2.0 MR3 (Released on August 9, 2006)
The following functions were added.

1. Corresponds to XSL Formatter V4.

47   V2.0 MR2 (Released on November 30, 2005)
The following functions were added.

1. The output of the four (fundamental) rules of arithmetic to XSL stylesheet
2. The output of the page number to XSL stylesheet
3. Corrected the bug that the property for the arrangement of the vertical axis of image object did not work.

47.1   The output of the four (fundamental) rules of arithmetic to XSL
stylesheet

With the previous versions, when the four (fundamental) rules of arithmetic is input to the object by using
"Expression," they were not reflected in XSL stylesheet. In MR2, they are able to be output into XSL stylesheet.

Example 1
<data>
<UnitPrice>120</UnitPrice>
<Count>4</Count>
</data>

With the above XML data, you can obtain the output of "120 * 4 = 480" in XSL stylesheet. Make project file as
follows and save it with "Save XSL stylesheet" in the File menu .

1. Input "UnitPrice" (the same as the element name) into "Variable name" property of the object that refers
to <UnitPrice>.

2. Input "Count" (the same as the element name) into "Variable name" property of the object that refers to
<Count>.

3. Input the calculation result as "UnitPrice * Count" into "Expression" property of the object that outputs the
calculation result.

The operators that can be used are the following 5.

■ Addition: +

■ Subtraction: -

■ Multiplication: *

■ Division: div

■ Remainder: mod

Example 2
<Mathematics>74</Mathematics>
<Science>65</Science>
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<Music>60</Music>

By using the above XML data, you can obtain the average of three subjects, and output it to XSL stylesheet.

1. Input "(Mathematics + Science + Music) div 3" into "Expression" property of the object that outputs the
calculation result.

2. Save the project by "Save XSL stylesheet" in the File menu. The arithmetic will be output to XSL stylesheet.

 Note;

1. The function cannot be used within the expression.
2. When one element is referred from multiple objects, and the four rules of arithmetic is operated by using

those objects, the error "Overlapping variable name" is displayed on GUI. Even in this case, the arithmetic
expression is correctly output to XSL stylesheet (However, the format by using that project file cannot
be done).

47.2   The output of the page number to XSL stylesheet

With the previous versions, when "currentPage()" which is the function to get page number is input to the object
by using "Expression," they were not reflected in XSL stylesheet. In MR2, it is able to be output into XSL
stylesheet. It is actually converted into XSL-FO as "fo:page-number" and output.

48   V2.0 MR1a (Released on March 16, 2005)
The following functions were added.

1. Corrected the invalid attribute name of XSL Stylesheet output.

49   V2.0 MR1 (Released on February 22, 2005)
The following functions were added.

1. Adds sample xml files used in manual(help).
2. Adds 'variable name' property to image properties.
3. Corrected the bug that saving the diagonal line properties did not work.

50   V2.0 (Released on December 20, 2004)
V2.0 was released.
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